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Wh a t is Freed o m Fo n e?
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OUR STORY
Freedom Fone was conceived by Kubatana. Founded in 2001, the Kubatana T rust of Zimbabwe seeks
alternative ways to inform and engage civil society in Zimbabwe; it aims to inspire positive social change
by sharing information and ideas via Internet, email, mobile phones and print publications.

In Zimbabwe, freedoms of association and expression are regularly repressed. T he political and
economic struggles over the last decade created a need to engage with audiences situated on the
margins of the information society. By taking advantage of both text and voice functions, Freedom Fone
provides a means to reach communities that do not have access to other media and remain under-heard
because of literacy and language barriers.

While internet in Zimbabwe has become more accessible, it is still available only to a minority, urban-
based audience. Mobile phone usage on the other hand has grown exponentially with over 50% of the
population - including many who live out in remote rural areas - currently subscribed to mobile networks.

Freedom Fone has proved to be a practical communications tool for small to medium sized organisations
working in a number of different sectors from community radio, agricultural development, education or
health programmes, to elections monitoring or emergency relief operations. Freedom Fone makes it easy
to interact on an information-on-demand basis with offline audiences that speak multiple languages and
may struggle to read or write.

YOUR STORY

T his book was written by our community to help you identify how Freedom Fone can help you and how
to implement it to meet your needs.

T o help you understand how Freedom Fone could help you, have a look at these sections - Real World
Examples features documentation of Freedom Fone in action and Other Possible Scenarios includes some
hypothetical examples written by people working in those sectors.

If you have an idea about how Freedom Fone could help you or a new and exciting way to use it we
would love to help you bring this to fruition! Feel free to contact the team via email at
info@freedomfone.org or call us on +2634776056
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WHAT DOES FREEDOM FONE DO?
Freedom Fone allows anyone with a phone to access or contribute information on a specific issue 24
hours a day and seven days a week. It takes advantage of audio and text to address language and literacy
barriers when reaching out to marginalised audiences that don't have access to other media. No internet
access is required by either you or your audience for this.

Freedom Fone uses interactive voice menus to deliver information to and record information from a
caller. You will be familiar with this kind of menu already: "press 1 to access your account, press 2 to
speak to a representative, press 3 to record a message...". We all sometimes have to deal with this kind
of system when we dial a number to top up the credit on our mobile phone account, or to talk to a
support person, etc.

Freedom Fone enables you to design your own interactive menus to:

Share  audio  inf o rmatio n with yo ur audience ; this audio information can take many forms
including voice menu (press 1, press 2, etc.), educational dramas, short news items, or even a song!
Organise  a po ll to enable your audience to vote on an issue using their phone;
Co llect SMSs  f ro m yo ur audience  - these might be updates about specific news events, alerts or
similar time critical information;
Get yo ur audience  to  leave  audio  messages  to share their opinion on a particular topic or
make reports in their own language.

T here are no geographical limitations to Freedom Fone. In fact it can be used and deployed in all
countries where there is mobile network coverage, and content can be recorded in any language - even
multiple languages, simultaneously.

In addition to ordinary mobile phones, your callers can use landlines and internet-based phones to access
the service. T his means that Freedom Fone can receive and deliver crucial information via mobile phones
or landlines in situations facing power constraints or where the Internet access is limited or interrupted.

Freedom Fone provides an installer that automates much of the setup, empowering a non-technical user
to independently set up a sophisticated telephony server in under 30mins.

Once you're set up, an easy graphical user interface lets you control everything you want to do through a
simple 'dashboard'.

Please note: Freedom Fone also has some security features but please be aware that all phones and telephony
services have security issues. We have provided chapters in this book that cover this issue from different
perspectives. If security is an issue for you or your callers please read this material.
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EQUAL ACCESS
Equal Access (www.equalaccess.org) works with marginalised populations through the use of innovative
technology to create positive social change. T hey are using diverse communications strategies to inspire
communities to promote economic development, human rights, womens' empowerment, youth
engagement and encourage positive action.

Equal Access has been using Freedom Fone in Cambodia and Niger since 2010. Both countries share
extremely low levels of Internet penetration. Although Equal Access uses a combination of traditional
broadcast and new media technologies for their programmes, mobile phones have proven to be the best
way to engage marginalised audiences.

T he programme "Our Community Voice: Many Voices, One Community" in Cambodia covers topics relevant
to the youth; in Niger, Freedom Fone is used to support a religious programme covering the issues of
extremism and religious conflicts, promoting peaceful dialogue and tolerance.

Graham Gardner, programme manager for Equal Access, was particularly interested to apply the voice
functions in Freedom Fone as a way to interact with audiences who may struggle with text-based mobile
technology such as SMS.

blank

"Mobile phones are increasingly used throughout all of these countries but literacy is a problem in places
like Niger and Chad. Even in Cambodia, about 20 to 30% of people cannot read. But a bigger problem here
is the fact that Cambodia uses a non-latin script which is not so widely used in technological formats,"
explains Gardner.

Although there are mobile phones available that allow audiences to produce text messages in Khymer
script, they are not widely used. Even for literate Cambodians, many don't know how to read an English
or phonetic Khymer message using latin script.

T he Voice Menu functions in Freedom Fone allow Equal Access to be a lot more inclusive with their
mobile programmes. "Our Nigerien staff described it as somewhat discriminatory that we only had SMS
available to users. So once we brought our Freedom Fone system online, we were being more inclusive in terms
of allowing those audiences that wanted to share their comments to call our line and leave a voice message
rather than having to write in text."

T he Cambodian programme received over 4,000 calls in 6 months out of which 50% left a message.
Same success in Niger, where 60% of the 2,000 calls ended with a message left. T he agreement Equal
Access concluded with the mobile operator Orange in Niger for a toll free number, hence tackling the
issue of call cost, had an immediate impact on the frequency of calls.

Equal Access makes the most of the 2-way communication with their audiences made possible by
Freedom Fone: they use it to gather feedback and build a community commentary: "People thoroughly
enjoyed it when we updated the system with other callers' comments. These community comments would start
conversation. "

Freedom Fone is also used to help test the impact of a message and the effectiveness of a campaign. T he
way audiences react helps them inform their content. "This is a way of educating the audiences about the
topics we are covering but also to creating an interactive feedback whereby we are providing an audience with
information and they in return are providing us with new ideas, commentary and general questions about our
programmes. This is then fed into the production of future content so it creates a cycle or loop."
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Freedom Fone offers easily accessible call data records, monitoring and reporting functions that provide
a treasure trove of information to help gauge the relevance and actual value of any programme and how
communities are receiving and interacting with a particular service.

"For us it's really all about creating a connection with the audience, creating interaction between our work, the
work of our partners and the people we are trying to serve. It is also about shared learning for us and any tool
that allows us to do that is a good one so we will absolutely continue to use Freedom Fone."

ROLE OF FREEDOM FONE:
Using voice to bridge literacy and text barriers
Overcoming limitations of SMS
Interacting with offline audiences
Evaluation and monitoring projects
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FARM RADIO INTERNATIONAL
Farm Radio International (www.farmradio.org) is a Canadian-based, non-profit organisation, that assists
small scale farmers in Africa with food security. Farm Radio works with over 290 partner radio stations
across Africa to train broadcasters, create radio scripts and conduct educational radio campaigns on
agricultural topics that can improve the livelihoods of farmers.

blank

"...there are a few shortcomings of radio: if you miss the show, you miss the info; with radio it is not
possible to make information available on demand. Radio also lacks a reliable channel for interacting
with listeners. This is a pitfall for Farm Radio because although radio is the primary 'media' source of
information for farmers, we know that their favourite source is their peers - other farmers!" 
-- Bart Sullivan, ICT  and Radio Specialist at Farm Radio International

Since January 2010, Farm Radio has been using Freedom Fone to increase the impact of their educational
radio programmes and involve more farmers' voices.

THE KUKU HOTLINE, TANZANIA

Early in 2010, Radio Maria in T anzania conducted a campaign on best practices for small scale poultry
farming. One specific objective was to help decrease chicken death rates from 60% to 20% with simple,
low-cost, very practical advice.

In partnership with Radio Maria, Farm Radio decided to hold a competition to assess how the poultry
farmers of the area had been impacted by the campaign. T he competition was set up using Freedom
Fone's Leave-a-Message (LAM) function and was advertised on-air through a series of radio jingles.

Farmers were invited to call in and comment on the impact of the campaign and asked what they
intended to do to improve their farming practices. Awards to winners were 20 colourful Kuku Hotline T -
shirts.

"First, I plan to build a proper house for my chickens to keep them safe and care for them - the money I
get from their eggs, I will use to improve my business. Secondly, I will open a bank account to save
money for my children's school fees. T hanks to the Kuku Hotline, thank you" 
-- Neema Mbise, One of the winners, Chicken Farmer in Morogoro, T anzania

T he service received over 1,400 calls in one month. On the final two broadcasts of the campaign, the 20
winning messages were broadcasted on Radio Maria.

T he Kuku Hotline became popular because it included the actual voices of farmers on the radio. T his
encouraged Radio Maria and Farm Radio International to use Freedom Fone to make radio more
interactive and create more participatory radio campaigns.
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FARMERS PHONE, GHANA

In Ghana, the Voice Menu function of Freedom Fone was used to share a variety of agricultural
information with farmers in two local languages: Akan and Ewe. T he farmer could select from a variety
of menu choices:

"To listen to market prices press 1" which would give the farmer updated market prices for the top 3
commodities from 3 local markets in the Volta Region;
"For a summary of last week's radio program press 2" would allow the farmer to hear a summary of
the previous week's broadcast;
"To leave a message for the radio presenters press 3" would give the farmer a chance to ask a question
or leave a message for the programme.

blank

"By providing farmers with up to date market prices they can make informed decisions. For example,
once I know that my sweet potatoes would sell for 1.2 dollars/kg in the Abotoasi market and 1.4
dollars/kg at Akatsi market, which is 20 km further from my home, I can decide whether it is worth
arranging transport to go the extra mile to Akatsi or not - it might still be too far away!" says Sullivan.

Between January and April 2010, the service received over 4,500 calls. T here was a group of about 50
farmers who used the service consistently from week to week and it would take them about two minutes
to get the market price information they wanted before ending the call.

Most calls were received before 6 am in the morning, when calls are cheaper. Although call costs remain
a challenge, farmers still used the service because they were getting actual value from the information
provided.

"We provided farmers with information that was really making a difference to them. And the radio stations we
partnered with naturally had the skills and equipment for audio scripting, recording and editing. For them, using
Freedom Fone proved very easy," explains Sullivan.

T oday, Farm Radio International continues to use Freedom Fone for agriculture related information and
have extended their reach to Mali. Opportunities in Uganda and Malawi are also under consideration.

ROLE OF FREEDOM FONE
Information-on-demand services
Participatory educational campaigns
Providing real-time information to rural audiences
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LIRNEASIA CRISIS RESPONSE
LIRNEasia (www.lirneasia.net) are a regional information and communication technology (ICT ) think tank
active across the Asia Pacific. T hey began working together with one of Sri Lanka's biggest NGO's,
Sarvodaya (www.sarvodaya.org) in June 2011 to use Freedom Fone in emergency response operations.

Whether during a flood, earthquake or tsunami, governments or emergency services usually have a very
short time to send out a warning alert to a large and diverse population around the affected area. In such
situations, the rapidity of response and accuracy of the information provided by any disaster management
system is of the essence. T his creates a great need for voice based communications to complement an
initial SMS text alert.

blank

"The character limitation of SMS limits the amount of information we can send when alerting the first
responders in an emergency. If we could deliver a short wake-up text message and a localised descriptive
voice message, that would be much more effective. That's where we found Freedom Fone very useful." 
-- Nuwan Waidanyatha, research fellow at LIRNEasia

Sarvodaya plans to combine SMS alerts (sent using Sahana or other bulk SMS applications) with Freedom
Fone's Voice Menus function to share important updates with villagers. SMS alerts will be sent to a
network of trained individuals in each village - known as first responders - with an additional request to
phone Sarvodaya's Freedom Fone lines for more detailed information about the evolving crisis.

Feedback, situation reports and requests for information and help from the field will be facilitated through
the Leave-a-Message function, as Nuwan Waidanyatha describes further:

"When Sarvodaya first-responders assess the damage and report the incidents for rescue and relief actions they
call Freedom Fone to leave a message. For example, several students evading the flood waters are stranded on a
building and need immediate assistance. This message is received at the Sarvodaya incident command center
and is processed to deploy the required resources."

When Freedom Fone's Campaign Dialer function is released in late 2011, it will be possible to automate
call-outs to the list of numbers in a Freedom Fone Phone Book. When recipients answer their phone, they
will be connected to a Voice Menu with updated information about the crisis. T his feature can make sure
people are alerted and informed of a crisis in the event that first responders fail to receive the initial SMS
alerts.
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Sarvodaya's Emergency Response T eam field tested Freedom Fone in a number of different districts in Sri
Lanka. T hey found that Freedom Fone provided a much needed structure for complementing early
warning alerts and for receiving situational reports from the field once a disaster has struck.

T his experiment points to the importance of integrating voice based communications as a complementary
feature in any emergency relief operation. Voice based solutions not only provide more information than
SMS, they also provide an immediate solution to language challenges faced by text communication. In
many contexts languages are not supported by SMS, some audiences may be illiterate or simply a culture
may be more predisposed to oral communication.

"From a global perspective, in our parts of the world people are vocal. We do business with voice. We don't write
big memos, we don't write big e-mails, you just pick up the phone and you make a call, you talk to the person
and you do your business. From that perspective Freedom Fone positions itself naturally in a very good way,"
says Nuwan Waidanyatha.

Based on these trials Sarvodaya is now implementing Freedom Fone as part of their emergency response
procedures.

LIRNEasia is further investigating how Freedom Fone integrates with the SAHANA disaster management
system and other open-source platforms active in crisis communications. Details of this report are
available at http://lirneasia.net/projects/2010-12-research-program/ff4edxl/

ROLE OF FREEDOM FONE:
Facilitating rapid response in a crisis situation
Communicating across literacy and language barriers
Integrating with other open-source systems
Flexible interaction with geographically dispersed audiences
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KUBATANA AUDIO DRAMA
T he experience of Freedom Fone in Zimbabwe has shown that high call costs can be a challenge to
getting callers to access information through Voice Menus. In 2009, the civic activist platform Kubatana
(www.kubatana.net) used Freedom Fone to launched Inzwa, a call-in news headline service. T hey
followed on with a constitutional reform information service, but came to realise that due to the high
cost of phone calls, callers were more willing to pay for news and entertainment than civic information.

T o test their entertainment theory, Kubatana experimented with micro audio dramas and Freedom Fone's
Voice Menus. T he dramas comprised 4 to 5 short audio episodes of roughly 2 minutes each, with the
episodes each finishing with a compelling hook to the next in sequence. T he idea was to use edutainment
as a means of sharing information that audiences would otherwise find tiresome or difficult to consume.
T he episodes were kept short to minimise call costs.

Launched in June of 2010, Tariro on Top was an audio drama that raised awareness about sexual
harassment in the workplace in Zimbabwe. T he drama is about a chauvinist boss, Mr Kunaka, who is
used to expecting sexual favours from his secretaries. Matters take an unexpected turn after he meets
T ariro, a woman who is prepared to risk her job by rejecting his advances.

Below follows a transcript of the audio drama where T ariro, still a new employee, meets Mr. Kunaka:

FELICITY: Uh-uh, jairai asikana. Hmmm your hair is so nice! What have you done? Wakaitirwa kupi?!

TARIRO : Oh, thanks Felicity. Yah, you know, I thought now I have been transferred to this office to work
for Mr-Most-High-and-Mighty-Kunaka, I should be looking really professional. T hat's why I thought short
was maybe better. I don't want to be a secretary forever handitika, and if I can impress Mr Kunaka with
my work . . .

FELICITY: Ahhh, my dear, T ariro, listen. About impressing Mr Kunaka -

MR KUNAKA: Hello ladies! Uribho Felicity, Uribho T ariro. Did you have a good weekend?

TARIRO : Yes, thank you Mr Kunaka. And I want you to know that I'm very pleased to be finally working in
this office.

MR KUNAKA: Excellent, excellent, well, we are pleased to have you here I'm sure. I've always thought you
had a lot of . . . potential.

Following on from the success of Tariro on Top, the Kubatana team created two other micro audio
dramas - Beckham in DZ and Big Dhara - to highlight issues troubling young sexually active adults. Focus
discussion groups were organised to identify and discuss common issues and thereby inform the script
writing process.
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T o minimise the loss of audio quality across mobile phone
networks, Kubatana used a professional studio to record high
quality audio files. T hey also engaged local drama students to add
life to the characters' voices. Aware that their audio files eventually
had to be downsampled for Freedom Fone, Kubatana made sure
to start the process with quality recordings.

T o promote the micro audio dramas, Kubatana make use of their
extensive mailing list of over 10,000 addresses and SMS list of over
22,000 numbers. T o engage new listeners they flight adverts in
local newpapers and print colourful flyers that are handed out for
free at traffic intersections. Call data Records show that advertising
a service this way often increases the number of callers.

blank

"Freedom Fone opens doors. It's a new way of sharing information with an offline target audience. The
popularity of Tariro on Top revealed that a service which deals with a social issue in an entertaining
manner with strong characterisation and dramatisation was most popular. Call lengths were up to 10
minutes at a time which shows that people will pay for a service they are interested in." 
-- Amanda Atwood, Content Manager, Kubatana T rust of Zimbabwe

Kubatana encourages feedback on the audio dramas and makes use of the Leave-a-Message (LAM) and
Incoming SMS functions to receive critique and suggestions.

ROLE OF FREEDOM FONE
Creating an information-on-demand service
Addressing social issues with edutainment
Integrating the collection and dissemination of information
Strengthening connections between Kubatana and their audience
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COMMUNITY RADIO HARARE
Community Radio Harare (CORAH) is one of the main community radio stations in Zimbabwe. Based out
of the capital city, they have been using Freedom Fone since October 2010 as an alternative to broadcast
for Free Voices Harare, a community news programme.

Despite a political agreement signed in 2009 promising to liberalise media channels in Zimbabwe, no
independent or community radio station currently has a licence to broadcast (May 2012). While CORAH
waits for the government to issue operating licences, using Freedom Fone as a means of community
outreach makes sense due to the widespread access to mobile phones.

CORAH used Freedom Fone to established Free Voices Harare as a citizen media initiative to encourage
self-expression in marginalised communities around Harare. T he service receives around 50 calls a day.

blank

"We have trained citizen journalists in 30 wards so in each of those areas there are people who are
trained to use Freedom Fone. People know how to phone in and deliver voice or text messages and even
to listen to news, radio documentaries and then impart that information to their communities as well." 
-- Givemore Chipere, Programming Manager, CORAH

CORAH is often first to break with local news stories thanks to the tips they receive from their network of
community reporters.

CORAH realised that the inability to transmit via traditional radio actually presented opportunities for
experimenting with new solutions for engaging with their community. Freedom Fone was particularly
useful because it gave people a platform to not only listen to news but also to share news tips and eye
witness reports from their areas via text or voice message.

"We saw it as an opportunity to offer people a platform for self-expression and it is working quite well because
we are not using the regulated radio frequencies that the government does not want people to use. We found it
as a very innovative way to offer people a means of self-expression," explains Chipere.
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Despite major challenges and lack of resources, Community Radio Harare continues to use Freedom
Fone in conjunction with other media platforms like bulk-SMS, audio documentaries, website
(www.corah.org.zw) and e-newsletters to build community listenership and participation. As Chipere
notes, all of the information they receive through their Freedom Fone service serves both as content for
their news service and helps to inform future programmes.

"Platforms like Freedom Fone allow people to communicate, allow people to broadcast in one way or another
without using the regulated frequencies that the broadcasting authorities are holding on to. The growth in IT
will present us with many opportunities for self-expression and communication."

ROLE OF FREEDOM FONE:
An alternative to traditional broadcast
A tool for citizen journalism
Creating an information-on-demand service
A complementary tool for other media
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O th er P o ssib l e Scen a rio s
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VACCINATION CAMPAIGN
Achieving full coverage in vaccination campaigns can be difficult. It depends a lot on community trust and
ensuring consistent information to target populations.

SHAMISO'S DILEMMA

Shamiso and her husband Musa have three children. T hey are devoutly religious and members of an
evangelical church that generally disapproves of vaccinations and other health interventions.

Now there is an outbreak of measles in their district. Health and child protection agencies have visited
their village pleading with them to take their children for vaccination.

Shamiso feels she should take their children but doesn't want to disobey her husband or their church
leaders and cause conflict. She feels torn between protecting her children and going against her culture
and religion. What can she do?

RAPHAEL'S STORY

Raphael is the local district vaccination campaign co-ordinator and is looking closely at the coverage in
the District. He sees that the campaign is faltering in the villages where the church has strong leadership.
He decides to act: he calls a meeting with the church leaders, and they agree to endorse the campaign.

Leaflets are drawn up with the church leaders endorsement and distributed; meetings are held. T he
villagers receive the information but they mistrust what is written. Nothing validates the statements made
that the church leaders now endorse the campaign. Numbers of vaccinations continue to fall in some
areas.

HOW TO MOVE FORWARD?

Raphael has heard about Freedo m Fo ne  and sees a solution. He sets up a team. T he finance officer
orders the equipment. T he IT  officer sets it up and the community mobilisers help to record simple Voice
Menus in their local language.

Raphael gets the church leader, Prophet Johannes, to record a Voice Message endorsing the vaccination
programme and asking members of his church to bring their children forward to the vaccination centres.
T his is the flagship message of their service. Raphael sets up a voice menu and sends an SMS to his
community mobilizers asking them to encourage villagers to call the number.

A LITTLE LATER ...

Shamiso calls the number from her village and she hears this voice menu ...

"To hear Prophet Johannes message on vaccination, Press 1" 
Shamiso and her husband Musa play the message together. T he voice of their church leader reassures
them.
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"To learn where and when to bring your child for vaccination, Press 2" 
Her and her husband agree to take their children to the vaccination centre immediately.

"To learn more about the symptoms of measles, Press 3" 
A few of the village children are sick and she is not sure if it may be measles or something else. T hey
decide to check up on them.

"If you see measles in your village and think a health worker should visit, Press 4 to leave us a message" 
Shamiso leaves a message with her village and her name on the Freedom Fone Service. A health worker
soon visits them and reassures them that it is not measles.

IMPACT

Raphael starts to see the numbers rise of parents coming forward. He uses the Statistics and Reporting
function of Freedom Fone to continuously monitor the levels of calls and direct his health workers to
areas that are still low in coming forward.

Raphael keeps Prophet Johannes in the loop and agrees to publicize a prayer service to be held in the
coming weeks so as to further endorse the campaign and give guidance to the villagers in the District.

Shamiso is proud and relieved that she and Musa found a solution to her dilemma and that her children
are protected.

T he district is evaluated and found to have the best universal coverage statistics in the campaign.

18



RESOURCES

Equipment

1 Computer to run Freedom Fone
1 x OfficeRoute
4 x Sim Packs from local Mobile Network Operator
1 x audio recorder to interview Prophet Johannes

Staff and Competencies

Proficiency in local languages and content creation
Ability to record and edit audio content

Advertising costs

T ravel costs for community mobilisers and airtime for them

ROLE OF FREEDOM FONE
A sensitisation tool
Personalised information that is critical to a campaign
Resolving cultural and religious conflicts
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SUPPORTING WOMEN'S RIGHTS
Kalila is a Human Rights activist. She lives in a medium-size city in an Arab country. One year ago she set
up a small organization focusing on Women's Rights. As part of a programme which also includes
conferences in schools and capacity-building of social workers, she is now running a Freedom Fone
Service aiming to denounce sexist comments or insults that women in her area often have to endure in
their daily life, in particular on the street.

T hanks to Freedom Fone, in the event of any incident involving abuse towards women in Kalila's
neighbourhood, victims can now use SMS to text in the insult addressed to them and the location where
it happened. T hey can also call into the service to Leave-a-Message and report their story. Kalila and her
colleagues maintain a database of all the incidents, which they have integrated with a map of the area
that is available on their organization's website. T he map, which is updated every week, provides a
humorous but accurate snapshot of "the most sexist areas in our community!"

Women can also call in to hear a selection of other women's testimonies, as well as listen to a weekly 3-
minute Audio Drama providing tips and tricks on how to respond in case of harassment and suggest
appropriate answers to insults.

Kalila and her colleagues used small posters to advertise the service and call for action. T hey placed them
in strategic meeting places such as schools, clinics, bus stops and also hairdressers and beauty centres.
Kalila's younger cousin, who is studying graphic design, helped design the poster using cartoon-type
characters so that it looks attractive. Word of mouth did the rest and the service now starts to be quite
popular in the city!

Mayssa is a 20-year old student living in the same city as Kalila. She hates receiving degrading comments
from men in the street and having them wolf whistle at her. She enjoys calling the service to listen to the
Audio Drama. Sometimes she calls several times a week to listen to the same episode with her cousins
or friends. She comments:

"You know, in our society many men do not think that women have the same rights. And even if this is a serious
topic, I like this audio drama because it is really humorous. Some of the testimonies are also amusing although
the problem is very real! Myself I really got fed up with this type of behaviour and it was a relief for me to hear
that I was not alone and that I have the choice to answer back. This programme really creates a spirit of
solidarity among women, and it reinforces our awareness about our Rights!"

Since Kalila's organisation uses the security version of Freedom Fone, the database of callers' numbers
can only be accessed by the administrator - you know, just in case. Kalila is now thinking about extending
the service to other countries. She is also in discussion with her friends Whalid and Susan on how they
could turn the service into a Radio Programme.
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RESOURCES NEEDED

Equipment

2 Computers, one used as a server, one for other normal office work including a secure back-up
database of incidents and callers.
A 4-SIM cards OfficeRoute
4 x Sim Cards

Staff and Competencies

1 part-time staff dedicated to listening to messages, making a selection of the most interesting
voices to re-broadcast, updating the map and coordinating with a volunteer script writer and a
group of actors to create audio-dramas.

Advertising costs

Printing and distribution of the posters (remember they were designed for free by Kalila's cousin!)

ROLE OF FREEDOM FONE
Activist campaign
Gender equality and empowering women's voice
Securing the privacy of callers
Collecting oral testimonies
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ENHANCING BUSINESS
OPPORTUNITIES
T ina has just started ZimOut: an entertainment magazine that covers events, an eat-out, cinema and
festival guide in her hometown Harare. For a while she has been struggling to cover print costs and
distribution in a city where there are already two established magazines that deal with events and
entertainment.

Both of her competitors already reach a young middle-class audience who are internet savvy and only
attend established and pricy venues. After hearing about the successes of Freedom Fone at her local
community radio where her friend Joe works, T ina decides to try a little experiment. She sees a chance
to use Freedom Fone to target a wider audience to complement her magazine. Besides the usual "hype"
places, she plans to promote interesting, less frequented venues and events, while attracting more
advertising. Can it work?

After downloading the latest version of Freedom Fone from the website (what has she to lose, after all
it's free!) and investing in a one sim-card MobiGater – the cheapest option that will suit her trial version -
she begins to plan her rocking new service.

T he idea is for a ZimOut hotline that anyone can call at any time, night or day, and receive instant, up-to-
date information on events, eating-out, films, gigs and upcoming events. T he service uses the Voice Menu
functions:

"To find out what is going on tonight in your area, press 1; to listen to the latest review of best restaurants, press
2." etc.

A final option encourages callers to Leave-a-Message and share their feedback and experience, with the
added incentive of winning a free year subscription to ZimOut for the most interesting story.

On each monthly edition of her magazine T ina dedicates a margin on the back cover to advertise the
ZimOut hotline. T o create more publicity, she also asks Joe at radio to publicise the ZimOut hotline in
their daily broadcasts. Within no time at all the service is receiving up to 300 callers a day and has a
number of entertaining text messages and soundbites for T ina to include on both her print and website
edition.

Wilfred and Sheila, an elderly couple who have become avid subscribers to ZimOut for its entertaining
stories and regular callers to the hotline had this to say:

"ZimOut is just for us. Before we hardly ever went out because we never knew what was on and when and what
sort of service to expect. Now, we can easily find out what's happening when we want."

Soon advertisers are interested in this new, interactive space and are asking to be featured on the
ZimOut hotline. With the added revenue, T ina decides to upgrade to a 4-sim card OfficeRoute; she keeps
two lines open for the ZimOut hotline, keeping advertising to a minimum so as not to turn-off callers with
longer and more expensive menus. She then offers the two other lines to post classifieds and to promote
events for a fee.

ZimOut has now become the most popular entertainment magazine in Harare, using its print and online
editions to run interesting features and reviews while running their Freedom Fone hotline as both an
advertising and informative entertainment space.
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RESOURCES NEEDED

Equipment

2 computers, one used as a server, one for other normal office work including updating the
website and creating the audio content
1-SIM MobiGater
4-SIM cards OfficeRoute
SIM cards

Staff and Competencies

Proficiency in audio editing and content creation
During the first weeks, T ina was doing everything on her own. Soon she had to hire a staff
member who could run the Freedom Fone service and their website while she concentrated on
advertising and the print edition.

Advertising costs

None! Remember T ina advertises the phone number in her own magazine and got a few spots for
free thanks to Joe.

ROLE OF FREEDOM FONE
T argeting wider audiences
Creating an information-on-demand service to compliment other media
Creating advertising revenue
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RECORDING ORAL HISTORIES
Imagine a walk through the city of Berlin. As you pass a now nearly invisible checkpoint where the former
Berlin Wall once stood, you can dial a Freedom Fone Service and listen to sound recordings that bring to
life the history of that particular spot.

Suddenly you can hear the shootings of fugitives from a once divided city followed by the celebratory
shouts on the day the Wall went down. Continue past the Dom (cathedral) and you can choose to hear a
historical account of the architecture but also the story about the original building plan which was
secretly hidden by one of the carpenters in the steeple.

An ordinary house may grab your attention because of the grafitti on the wall. As you listen to
information left on the Voice Menu function you find out that during World War T wo a Jewish family was
hiding in the attic to escape the holocaust. Later you pass a house where the poet and playwright Bertold
Brecht once lived. You can listen to one of his most famous poems while you rest a little.

Now imagine the city you live in. You'll find that nearly everything has a hidden story to tell: a house, a
tree, a street, a river, an abandoned train track... Even an empty space might have a story to tell – missing
houses that were once a distinctive feature of the landscape or environment and are now reduced to
dust. But somewhere a living memory survives.  

Imagine your community Council, a cultural organisation or even a group of students using Freedom Fone
to build a virtual history of your city or community. Audio content is created by a small team of editors
and uploaded onto alternate Voice Menus that can be listened to on an on-demand basis including a mix
of speech, music and poetry. T he service is widely advertised using flyers or posters to allow the general
public to Leave-a-Message in places where they recall important events that happened at a certain time or
place. Callers' stories can be stored on a public archive linked to an interactive online map while being
integrated back into the service.
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As long as you are carrying your mobile phone you can call on the spot, listen to recordings that trigger
memories and participate in creating a collective history. Reminding people of their cultural and collective
heritage can create a sense of shared memory, common belonging and civic solidarity in any city or
community.

RESOURCES NEEDED

Equipment

2 Computers
1 x OfficeRoute
4 x Sim Cards from local Mobile Network Operators

Staff and Competencies

Proficiency in content creation (importance of historical accuracy, ability to tell stories and read
poems)
Staff dedicated to listening to messages, making a selection of relevant ones, updating the map
Legal counseling on archives' use and negotiation with the City

Advertising costs

Creation and distribution of postcards

ROLE OF FREEDOM FONE
Recording oral histories
Mobile information-on-demand
Sharing collective memory
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ELECTION MONITORING
As of June 2012, SODNET  in Kenya are working to integrate Freedom Fone into the Uchaguzi platform that
is now being used in 4 different African countries to monitor elections. Uchaguzi is a civic platform that
uses multiple channels to crowd source information, document violations and mobilise resources to
address problems raised by accredited monitors or the general public.

National elections are highly fraught events in many countries. Electoral fraud, vote buying, intimidation,
violence, media censorship and abuse of government resources are some of the issues that plague these
events.

Freedom Fone can be an important addition to the platform as it allows an organisation's staff, trained
monitors or the general public to get involved if there is a critical event or situation thanks to the Leave-a-
Message function. Reporting via voice messages can be easier to do while remaining vigilant and staying
out of harm's way and the organisation can always follow up on a caller's message to verify and clarify
information.

Voice Menu functions can also provide a useful service to rural and/or disconnected audiences by
providing information on demand news updates as an election unfolds. T his would be particularly
valuable to callers as an alternative to highly politicised broadcast channels. Election monitors and staff
can also benefit from this service once they are in the field and disconnected from their usual sources of
information.

Freedom Fone's Security functions allow an organisation to limit access to callers' personal details to
trusted staff while allowing other staff and volunteers to read the content of SMSs and listen to voice
messages. T his prevents the abuse of information that could jeopardise the identity and whereabouts of
monitors or callers.

26



RESOURCES NEEDED

Equipment

2 x Computers
2 x OfficeRoute
8 x Sim Cards

Staff and Competencies

A communications team that trains monitors, volunteers and communities to use the Freedom Fone
election lines.
T wo internal staff who are competent in creating and editing audio content, translating/transcribing
voice messages, forwarding pertinent information to relevant organisations and who are security
conscious.

ROLE OF FREEDOM FONE
Rapid response in a crisis situations
Collection and dissemination of information
Oral testimony to validate situation reporting
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AT THE RADIO STATION
Radio stations are in many ways, ideally positioned to benefit from and launch a successful Freedom
Fone service:

Radio stations already have an audience
they are familiar with the challenges and opportunities of audio
they usually have in-house IT  competencies to support the installation of Freedom Fone
they have a powerful channel for advertising their Freedom Fone service through on-air
announcements/spots on the radio
Freedom Fone can leverage the impact of any radio programmes.

Imagine you have a radio station that is packed with a schedule of popular radio programmes hosted by
presenters who each have a group of loyal listeners. Perhaps your station is looking for new ways to
interact and engage with listeners because you lack a comprehensive system for two-way
communications with listeners. Here follow some ways that Freedom Fone can be used at the radio
station.

GATHERING YOUR LISTENERS' VOICES

Including the voices of listeners in radio broadcasts adds a richness and depth to any radio programme
but is especially powerful for community radio stations. Getting into the field to conduct direct interviews
can be expensive and logistically difficult. T he Leave-a-Message functionality of Freedom Fone enables your
radio station to receive a variety of audio messages from your listeners. Here are a few of the possible
applications:

Citizen Repo rting: Citizens can become reporters by recording their news stories directly into the
station's leave-a-message inbox;
Wedding and f uneral anno uncements  can be recorded into a community announcements leave-
a-message inbox for replay on-air at a later time;
Call in questio ns  can be recorded by callers and answered on-air by the show's presenter;
Games  and co mpetitio ns  can be created on-air and listeners are invited to participate by leaving
a message. Radio presenters can then re-broadcast the winning entries;
Multiple  Leave-a-message  inbo xes  allows each presenter of a programme to have their own
service on the Freedom Fone. It's possible to have different phone numbers per service;
Audio  auditio ns  for new DJs can be conducted by asking applicants to call in and leave a message
sharing why they think they're a good candidate for the job.

How would you use the Leave-a-message service at your radio station?

GATHERING YOUR LISTENERS' OPINIONS

T hrough the SMS poll functionality of Freedom Fone, audience members are able to participate in opinion
polls on topics by sending an SMS from their (or someone else's) mobile phone. As a radio station,
conducting frequent listener polls can be a powerful way to get your finger on the pulse of your listeners
in a quick and measurable way. A listening audience is usually keen to participate when possible and polls
can deepen their relationship with your radio station. A few possible applications of SMS polls at the
radio station:
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Acco untability: Your radio station can ask your audience to report on the status of public services
in their area including clinics, power outages and garbage collection;
So ng o f  the  day: Listeners can vote for their favorite song of the day;
To mo rro w's  to pics : Invite your listeners to vote on topics they would like to learn more about in
upcoming broadcasts.

What ideas do you have for using SMS polls at your radio station? Lets talk!

You can also receive standard text messages using Freedom Fone's Incoming SMS function. Any message
the doesn't qualify as an SMS poll 'vote' will automatically be received as an Incoming SMS. T his means
that you can receive free format queries, reports, tip-offs, feedback and other requests via ordinary SMS
if you wish.

GIVING YOUR LISTENERS AUDIO-ON-DEMAND

By creating Voice Menus, content from the radio station's different radio programmes can be used to
make précised versions of audio information available "off-air" to listeners over the phone. Information-
on-demand allows your audience to choose when and from where they want to listen to audio you make
available. A few possible ways to use Voice menus at the radio station include:

News summaries : Highlights from each day's news can be recorded live and then edited into
short audio segments for listening on demand through a phone call.
Weather f o recasts  and market prices : Commonly accessed information which has been
broadcast throughout the day, can be very useful for listeners to get on demand.
Advertis ing rates : Audience and community members can easily learn about your rates if the
latest information is made available.

What information would you make available through Voice Menus? Lets talk!

T o announce the service to your listeners, why not prepare several radio spots that explain the new
features as well as the phone numbers to call. Stickers and postcards advertising the service and phone
numbers can be distributed in communities and handed out at any radio events.

T he Freedom Fone Service can be used to generate an extra income stream by having sponsors put their
own jingles in the Voice menu and/or Leave-a-Message services. For example, callers could hear a short
message "T his competition brought to you by..." before they are prompted to record their message for
the radio station. T his sponsorship could be changed periodically. 
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RESOURCES NEEDED

Equipment

1 OfficeRoute with 4 SIM cards
1 dedicated server connected to the station's local area network, allowing the on-air studio to
access callers' messages and SMS polls

Staff and Competencies

1 audio technician to work with the station's presenters and help produce their content
Each presenter administrates their own Leave-a-message box to manage their competitions and to
check for questions and comments from listeners

Advertising costs

N/A

ROLE OF FREEDOM FONE
Gathering listeners' voices
Opinion polling
Generating extra income
Précised information on demand
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C rea tin g  yo u r Freed o m Fo n e Service
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INTRODUCTION
Freedom Fone is designed to get an information service up and running rapidly, within a matter of hours
of installing the software. You can just go ahead and do this and it can prove to be very effective with
very little planning or set up. T his makes Freedom Fone ideal for contexts where rapid deployment is
necessary. However if you have the time and resources you may wish to consider spending more time
on planning and producing your Freedom Fone information.

If  security o f  inf o rmatio n f ro m and abo ut yo ur audience  is  a big  issue  then lo o k at the
chapter o n security.

If you decide to dedicate the resources to planning then this section outlines the steps you can take to
create your information service:
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EQUIPMENT
Freedom Fone is free, simple to install and easy to use. T he basic setup is portable (you do need a
power supply though) and requires very little to get up and running.

If you'd like to see how Freedom Fone works without installing it, you can try our online demo:
http://demo.freedomfone.org

EQUIPMENT SETUP AND COSTS

If you decide to install the software and set up your own Freedom Fone installation, here's what you will
need and some approximate costs:

  

Notes: 
1. Freedom Fone does not run on Mac hardware and we recommend installing on non-Macintosh computers. 
2. Backup inverters must be of the pure sine wave type.

For procedures to install the Freedom Fone software, hardware requirements, connecting your hardware
and testing your SIM cards - see the section Technical stuff.
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WHAT DOES MY AUDIENCE NEED?
A phone (fixed/landline, mobile phone, or Skype with call out credit)
Mobile phone credit if calling from a mobile phone
Adequate reception if calling from a mobile phone or internet access if using Skype

UPDATES AND MAINTENANCE

From time to time you may encounter technical challenges and it is therefore a good idea to have
someone technical help purchase, install and set up your Freedom Fone service. T he software is
periodically updated as new features are released or bugs fixed. For these reasons, it is recommended to
have access to a technical person when deploying Freedom Fone (for more information on staffing issues
see the Organize your staff chapter).
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KNOW YOUR AUDIENCE
T he most important part of your Freedom Fone Service is knowing your audience. As you build the
service, it is your audience who will be calling in to use it, so it is worth spending some extra time to get
to know more about them. T he better you know your audience and their information needs, the more
effectively you can design the service so that it works for them!

T he following are some thoughts for you to consider as you get to know your audience better.

WHAT LANGUAGES DO YOUR AUDIENCE SPEAK?

It is possible to make your Freedom Fone Service available in multiple languages to reach a wider
audience; this also increases the amount of work required in preparing audio content. Decisions about
what languages you will provide your service in will impact who uses the service and the value they
attach to it.

WHAT IS THE AGE OF YOUR AUDIENCE?

Young people tend to be more technology savvy when it comes to using mobile phones and will likely
find it easier to learn to use the Freedom Fone Service than an older generation. As you design the
service, keep in mind how to best communicate with your target age group.

WHERE DO THEY CURRENTLY GET INFORMATION?

It is quite possible that your audience are getting the information you are proposing to offer through
other means at the moment. It is useful to find out as much as you can about these sources and assess
their strengths and weaknesses. T his will guide the design of your Freedom Fone Service to improve
upon existing sources and offer new value.

WHAT DO THEY CONSIDER VALUABLE?

If a caller finds the information you make available valuable enough, they will bear the cost of making the
call to your Freedom Fone Service. Find out what makes your information unique and consider how to
prepare it in a concise way so that it is smoothly accessible over the phone.

WHAT DOES YOUR AUDIENCE FIND FUNNY?

Humour is an excellent way to keep people coming back to your Freedom Fone Service again and again.
Find out if there are comedians, jokes or types of entertainment that you could integrate into your service
to keep it entertaining and informative at the same time.
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INCOME LEVELS OF YOUR AUDIENCE?

T ypically those with a higher income level will spend more time on your Freedom Fone Service compared
to those with a lower income. Many people are conservative with their mobile phone airtime so it is
important to consider who you want to reach and what they will consider valuable enough to make that
call to your service.

WHAT MOBILE NETWORKS DO PEOPLE USE?

Certain mobile networks may be more popular with your target audience than others, this can help guide
you in many ways including approaching a mobile network to partner with, for example to get a toll-free
number. It is also possible to take advantage of certain tariffs and promotions offered by a network to
lower the cost of calls.

CONDUCT A FOCUS GROUP DISCUSSION

One excellent way to further conceptualize and design your Freedom Fone Service is to invite the very
people who will be using it to talk as a group! If you can arrange to travel to where the audience is based
and make it easy for them to participate you will increase your chances of getting a higher number of
participants.

Consider dividing the participants into three groups: Adult men, Adult women and youth - this can help
you get different perspectives and allows participants to share more freely.

Usually, the outcomes from these discussions will be very helpful in refining your initial ideas about the
Freedom Fone Service into something even more attractive and useful to your audience.

SETUP A STAKEHOLDER MEETING

T he outcomes of the focus group discussion with your audience can be used to gather all the
stakeholders involved including the ones who will be the information sources that will create the content
for your service. A participatory process of engaging this group with a facilitator to lead the process can
help ensure that your service is relevant, realistic and most importantly - of value to your callers.

EDUCATING YOUR AUDIENCE

For many callers this will be the first time they have used an Interactive Voice Response (IVR) system - they
may need some extra help in understanding how to use the service/technology. Here are some possible
ways to introduce them to your service:
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USE THE RADIO TO DEMONSTRATE

A familiar and likeable radio presenter could be a perfect candidate for demonstrating and introducing
your audience to how to use your Freedom Fone Service. By making an example phone call to your
service live on-air through the radio, your audience can hear an actual example of your Freedom Fone
Service and how to interact with it. T he radio presenter will gently guide them through the steps. T his
broadcast can be recorded and replayed as a radio spot throughout the day on the radio.

FOLLOW UP WITH ONE-TIME CALLERS

If IVR is a new experience to many of your audience they may hang up in the first five or ten seconds of
their first call because they are uncertain of what to do. Consider having a real person follow up with
these one-time callers with a phone call to ask the caller if they need any help with using the service or
have any questions. T his also builds a nice connection between you and your audience.

DOWNSTREAM TRAINING IN PUBLIC PLACES

Public places where many of your audience might be gathered on a daily basis such as markets, clinics,
churches, mosques, bus stops etc can be an excellent place to demonstrate the usage of your service.
Consider having a battery powered PA address system or loudspeaker connected to a mobile phone and
demonstrate how to use the Freedom Fone Service. T his can also be an excellent place to hand out
stickers, postcards or other marketing materials advertising your Freedom Fone service phone numbers.

CHECKING IN WITH YOUR AUDIENCE

Are you on track? See the chapter Monitoring and evaluation.
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CHOOSE YOUR INFORMATION
SOURCES
Once you feel you know your audience well enough and understand their information needs, the next
step is to get to know your information sources. T hese information sources, as there may be several,
are how you create your content and are at the heart of your Freedom Fone Service (unless you are just
using the Leave-a-message functionality exclusively and not using the voice menus). T he following are
some possible examples of where your information sources can come from. T his list is by no means
exhaustive.

Scripted co ntent: eg. A micro drama with characters and a storyline could be produced as a part
of a campaign with episodes shared on a weekly basis. T his requires writers and voice actors.
Third party so urces : eg. Market prices printed in the newspaper can be recorded into audio and
made available through voice menus on the Freedom Fone Service.
Previo us ly bro adcasted audio : eg. A radio station that broadcasts news headlines, weather
forecasts or important information throughout the day can also make a shortened form of the
audio available on-demand on a Freedom Fone Service
Caller co ntributio ns : eg. Re-use the voices and stories recorded from your callers who have
used the Leave-a-message function and make their recordings available for others to hear on the
Freedom Fone Service.

These are a few possibilities - what information sources are you planning to use?

SELECTING INFORMATION SOURCES

Because the information sources are the heart of your Freedom Fone service, it is worth mentioning
some other considerations that may help you get your service running smoothly from the get go.

Security: In instances where sensitive information is gathered you might consider an information
verification process that suits your service. If caller security is a concern where exposure may add
to vulnerability, consider implementing the security functions discussed in the Security chapter in the
Setting up section.
Reliability: If you are planning to use information sources from outside of your organization such
as agricultural extension agents, community media organizations or election monitors, it is
important to consider their ability to reliably deliver information to your service. Consistency is
important to keeping your audience engaged - so choose information sources that can be
consistent. For mission critical services it is worth making back up plans in case your sources are
unable to deliver their information.
Co pyright and o wnership: It may seem obvious but you want to ensure that the content you are
including in your Voice menus is in fact owned by you or you have permission to use and share it
freely.
Relevance : Based on knowing your audience (see previous chapter), you want to choose
information sources that your audience find relevant and worth making a call to listen to.
To picality: "Stale news is no news" - people want fresh and up to date information. When
selecting your information sources, make sure you can keep things current.

38



HOW OFTEN TO UPDATE YOUR INFORMATION?

Keeping the information and content on your Freedom Fone Service up to date is one of the best ways to
ensure that your callers will use your system on a regular basis. It is up to you and your audience to
determine what the frequency of these updates will be: eg. daily, weekly, bi-weekly or monthly. Once you
have identified the update schedule of your service, it is important to stick to the rhythm so that the
audience know how often they can expect to use your service and when.

First time installers of Freedom Fone often underestimate the amount of work and time that goes into
maintaining your service. You might like to try creating some audio content before committing to a daily
update.
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DESIGN YOUR SERVICE
Now that you know your audience's needs and you have an idea of where your information sources are
coming from, it's time to design the architecture of your service. Freedom Fone software makes available
a variety of components to help you interact with your audience. You can build your Freedom Fone
Service out of a combination of any number of these components (see sections Real life examples and
Other possible scenarios for examples of how others have used these components to create their Freedom
Fone Services):

Leave-a-message  (LAM) - T he LAM function is an effective way of establishing two-way
communication with your callers. With the Leave-a-message function the caller can leave a question,
comment or report in audio form on your Freedom Fone system. Audio messages enable your
callers to express themselves more freely and Freedom Fone captures those messages without
loss of meaning or character. T he content left by your callers can be played and listened to from
the Freedom Fone interface. In addition to being a platform for leaving questions, the Leave-a-
message service can be useful as an alert platform for callers to alert you to issues that need your
attention. Content left by callers can also be re-used, for example you could select 5 stories
submitted for a competition using LAM, re-broadcast these and allow the public to vote for their
favourites. Voice messages can also be downloaded from Freedom Fone as MP3 files. (For more
information see the Leave-a-message chapter in Setting up)
Vo ice  Menus  - enable you to create an information tree which your callers can navigate through
with the aid of dialling keys on a telephone keypad. You can imagine a voice menu as a grouping of
similar content which you would like your callers to access. Each content item in your menu will be
linked to a unique digit on your telephone keypad. T he process of embedding voice menus within
existing voice menus, which we call nesting, allows you to extend your information tree and hence
provide more content to your callers. It's worth noting that multilingual services can be created by
linking voice menus. (For more information see the Voice menus chapter in Setting up)
Inco ming SMS - allows you to receive ordinary SMS messages and view them in a reader friendly
interface. T hrough the Freedom Fone interface you can then export the SMSs into any content
management service of choice. Freedom Fone does not have the functionality for you to send
SMSs. T here are already several tools available to send SMSs effectively and integration with one
of these tools, FrontlineSMS, is on the agenda for 2012. 
(For more information see the Incoming SMS chapter in Setting up)
Po lls  - A simple and fast way to measure opinion on an issue is to conduct SMS-based polls. SMS
polls enable your callers to respond to a structured question via an SMS response. As the SMSs
arrive on the Freedom Fone system the individual SMSs are tallied and a summarized tabular output
is generated. In scenarios which need urgent action but yet rely heavily on evidence-based
information to take the first step, SMS polls can be a powerful and effective tool. 
(For more information see the Polls chapter in Setting up)

SKETCHING IT OUT ON PAPER

One of the best ways to get an idea of how these components fit together as building blocks in your
Freedom Fone Service is to draw it out on paper. (For an example of how Voice Menus can be organized
into a service see chapter Voice Menus in the Setting up section).

Putting your ideas on paper is helpful because several people can work together, it's easy to illustrate
your ideas and can help simplify and clarify the creation of your service.

In our experience, you need an operational staff member or volunteer to maintain the system. Ideally,
their roles should be thought of as an outreach officer to your audience.
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Resources they will need:

T ime to manage the Freedom Fone Service
Mobile phone credit to coordinate with information sources
Email and web access
T ravel allowances to meet with audience and stakeholders
Simple audio recorder
Computer access to

Edit and produce Voice Menus
Check Leave-a-message recordings from callers
Check Incoming SMS

For more information see chapter Staffing your Service.

HOW OFTEN TO UPDATE YOUR INFORMATION?

See the chapter: Organise your staff.

PLAN TO REFINE YOUR SERVICE

Your Freedom Fone Service is a continually evolving creation - as your audience grows and changes, so
should your service. Conducting surveys with some of the "top callers" who use your service frequently
can be an excellent way to get insight into what people like about your service - consider consulting your
top callers when you are ready to make some changes to your service. Call data records (CDR) and
Freedom Fone's inbuilt System data can provide you with comprehensive statistics that will give you an
idea of how people are using your system. See the chapter on Monitoring and Evaluation for further
information on this topic.
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CREATE VOICE MENUS
Now that you have designed an architecture for how you will use the various components of Freedom
Fone to design an information service, you will need to think about creating voice menus.

T he last thing that you want when building a voice menu is to bore your audience or even worse let them
get lost in the menu.

T o build a successful menu:

Stick to  s imple  language  which people can understand; avoid using complicated medical or legal
terms for example.
Keep yo ur intro ductio n sho rt  it is important that you let your callers know what to expect
immediately: example: "Welcome to the Cholera epidemics emergency information service".
Limit the  number o f  menu cho ices : People tend to forget if they are offered too many choices.
Make a pleasant erro r message : T he system should always take the blame for errors. "Sorry, I
do not understand your choice; do you want to press another number?"
Keep yo ur inf o rmatio n up to  date : Let your audience know how often they can expect to find
new information on your service. T his will help you keep them calling back.

Here is an example of an efficient voice menu:

"Welcome to the Cholera epidemics emergency information service ; this information is updated twice a day.
Please listen carefully to the following five options"

For signs and symptoms, press 1;
For first aid treatment, press 2;
Emergency treatment centers, press 3;
Avoiding contagion, press 4;
To leave us a message, press 5;
To end this call, just hang up.

For more information about how to create voice menus in the Freedom Fone software, see the Chapter
Voice menus in the Setting up section.

FEMALE VOICES

When considering the voice that will be used on the audio menus (the host), consider choosing someone
who the audience likes and can connect with - in our experience callers prefer to hear a female voice as
a host.

LANGUAGE SELECTOR

T he Language Selector helps you manage multilingual voice menus. 

If, for example, you want to deliver your voice menus in English and Swahili, you would first need to
create separate content files and voice menus for each language. T hereafter, you can link the voice
menus using the Language Selector.

T o create a language selector, navigate to IVR Centre > Language Selector. On the page shown below, click
on the Create New button.
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On the next page, shown below, you enter the name of the Language Selector and upload the audio files
for the instructions and the invalid message. 

At the bottom of the page, under Menu Options, select the type of service (Voice menus, Leave-a-message
menu, Content) you wish to link to the top menu of your language selector. If you have created the same
voice menu in different languages, you would select Voice Menus from the pull down menu.

Once you have made a selection, further options will become available to you, enabling you to set up
navigation for your voice menus. Save the page after making your selections.
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Once you have created a Language Selector you can return to edit it using the edit icon on the Language
Selectors page. You will note that the Edit Language Selector page looks just like the Edit Voice Menus
page. 
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ORGANISE YOUR STAFF
Keeping your Freedom Fone service running requires staff or volunteers. It is common that people
underestimate the work that is needed to manage the content, communicate with callers and monitor the
usage of their Freedom Fone service. It is therefore best to plan from the start to have staff in at least
two capacities: technical and operational.

Note: we know that budgets are often limited in organizations planning to provide a Freedom Fone
service and the workloads for current staff is typically already high - adding the following tasks and
resources may be too much. It should be pointed out that Freedom Fone can certainly be a part-time task
for existing staff members if you are not able to dedicate full time staff to the service, however we
recommend planning for success by freeing up staff and financial resources.

DUTIES

T he following are some typical tasks that could be assigned to two different staff members involved in
your Freedom Fone service:

Technical s taf f

Purchases and sets up the equipment
Installs the Freedom Fone software
T roubleshoots, maintains and updates the system
T rains the operational staff on how to use the system
Supports operational staff with recording, editing and uploading voice menus

Operatio nal s taf f

Considers audience needs and liaises with them
Scripts and records voice menus
Checks for and replies to incoming audio messages and SMS
Incorporates caller contributions
Administers SMS polls
Exports and analyses system data
Conducts audience surveys and evaluations
Gathers contributions from external information sources

RESOURCES NEEDED FOR YOUR STAFF

In our experience, the operational staff in particular need the following resources to help them in
managing the Freedom Fone service:

Mobile phone credit to coordinate with audience and information sources
Email and web access
T ravel allowances to occasionally meet with audience and stakeholders
Simple audio recorder to gather interviews in the field
Computer access to conduct the following tasks:

Edit and produce audio menus
Check Leave-a-message recordings from callers
Check SMS
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T ry-and-see is probably the best approach to finding an efficient workflow with your staff and resources -
with time you will know what you need to adjust to keep the service running. T his will likely change over
time as your service changes.
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ADVERTISE YOUR SERVICE
So, you have created your Freedom Fone service and you are ready to get the word out and advertise. A
crucial question to address now is: how are you going to spread the word about your service? T his
chapter looks at what is involved in advertising your service.

BUDGET FOR YOUR ADVERTISING

One common oversight when creating a Freedom Fone service is to forget about the costs associated
with keeping your service running and advertising is a big part of this - people cannot call the service if
they don't know about it or which number to call. Depending on which of the advertising techniques you
choose to use below, it is important to set aside some money in your annual budget for this.

ADVERTISING TECHNIQUES

Because your primary target are people who have limited or no internet access, many of whom may be
semi- or illiterate and may speak minority languages, it is important to carefully consider your advertising
methods to suit your target market.

We recommend prioritising the following offline advertising techniques:

Newspaper: advertising in papers that are popular among your audience (Kubatana, when
deploying Freedom Fone for an edutainment audio drama, even got the idea to place personal
advertisements in local daily newspapers to pique the interest of the many Zimbabweans who read
the personals!).
Po sters : placed strategic meeting places such as schools, clinics, bus stops, civil society
organisations, etc. Consider using illustrations, cartoons or other images to make your information
more broadly accessible.
Po stcards  and stickers : that advertise your service can be distributed at traffic lights during peak
traffic periods, inserted into newspapers, or distributed at the same points mentioned for posters.
Co mmunity Radio : depending on your budget you could either buy an advertising spot or
participate in an existing popular talk show where you can discuss your project and thereby
advertise for free. Ensure your target audience falls into the catchment area of this radio station,
particularly if you're paying for the time!
Lo ng term pro jects : where the telephone numbers remain the same for longer and the content is
regularly updated, you might consider advertising your number on high-turnover, affordable
consumables - for example on the plastic wrapping on loaves of bread, a commodity that everyone
buys on a regular and consistent basis. You might consider running a competition in conjunction
with the bread manufacturer which raises your profile (and increases your coverage) and also
encourages people to buy their product. T his method would help reach small rural communities
that congregate around the general store in their area - they might not have access to newspapers,
might not be in a radio catchment area, but they will buy bread.
Packaging: Kubatana trust printed newspaper-sized sheets used for wrapping produce by local
vendors thereby disseminating information from the vendor to the person buying the product, to
their home and its inhabitants and on - something similar could be used to advertise your numbers
and educate your audience on using your Freedom Fone service.
Freedo m Fo ne  itse lf ! Once your service is up and running, you can use your own service to
advertise upcoming audio changes, outreach programs or the location of relevant materials to be
accessed.
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Note: all yo ur advertis ing must include  a "Call to  Actio n". Example: "Call 077123456 to find out more".
In the case of a poll, you have several criteria to communicate to your audience: start and end date/time
for the poll, multiple choices answers, poll code and of course the phone number to which participants
should send their SMS replies.

Do you have some advertising ideas you can share with us?

ONLINE COMMUNICATION

Does your audience use the internet? Even if they don't - if you have access to the internet, and maybe
run a website, you might want to consider the following channels for advertising and spreading general
awareness about the service:

Email your information to a list of contacts you have;
Post your information the websites and blogs of your peers;
Making an announcement on your website, Facebook and T witter accounts.

EDUCATING YOUR AUDIENCE

An important step in ensuring that your audience call in and use your Freedom Fone service is to provide
training to new callers. Please see the chapter Know Your Audience for some suggestions on how to do
this.
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MONITOR AND EVALUATE
Once your Freedom Fone service is up and running, it is important to keep a finger on the pulse of your
service and to periodically monitor its success and impact. Freedom Fone has some inbuilt tools that can
be used to track caller usage of your service. In the chapter Organise your staff, we make some
recommendations about assigning the task of monitoring and analysing your system data.

Ways to monitor and evaluate your service:

Fo cus  gro up discuss io ns : Arrange to visit communities where your audience is based and are
prepared to talk about your service. T his face-to-face communication can not only help you
evaluate your service but also provide you with new ideas!
SMS po lls : You might like to try polling your audience with a simple closed question, such as "Have
you found our content useful?". T his could be sent out to callers by making a voice menu explaining
how to vote, sent as a bulk SMS to a list of numbers or by using one of your advertising channels.
Co mpetitio n: You might start a competition, asking your callers to submit their ideas for content,
with a small prize for those interesting contributions which are implemented
Call data reco rds  (CDR): Freedom Fone keeps track of usage statistics on all incoming calls and
SMSs (see chapter on Statistics in section: "Setting up").

Number of callers - You might map the number of calls at the beginning of your campaign and
watch to see if they grow, you should notice peaks and troughs around advertising and
education campaigns, new content, polls and competitions.
Length of calls - how long your callers are staying on the line? T his may indicate that your
content is too long (and therefore too expensive), or not engaging enough, or technical errors
and a misunderstanding of how to use the menus may also be indicated.
Popular content - which content your callers are accessing, which may help identify which
information they consider more useful and relevant. Contacting one-off callers might be helpful in
identifying which barriers prevented them from accessing your service again.
SMS poll statistics - will show how many callers participated in your poll, and the number of
invalid votes will help you evaluate how successful your caller education campaign has been.

Pho ne  surveys : Once you have extracted and analysed your CDR stats you can create two lists of
groups of audience members to survey through a simple phone call:

Top 20 callers: T hese are your regular customers. T ry sending them an SMS and ask them if they
are willing to participate in an audience survey. You can then prepare a short survey to be
conducted over the phone - this will help you evaluate and refine your service, especially
focusing on what people like about your service.
One time callers: It is just as important to also contact people who are not using your service
regularily - they only called your system once and never called back. Surveying them can help you
find out how to improve your service and remove barriers to its use.

What are some of your strategies for Monitoring and Evaluating your service?
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Settin g  U p

50



LOGGING IN
Note: T his section assumes that you have already installed the Freedom Fone software, connected your
hardware and tested your SIM cards. All these procedures can be found in the section Technical Stuff.

When you open the Freedom Fone interface, you will be presented with a login screen which you must be
authenticated before you can continue. 

T he default login details are:

User = Admin 
Password = thefone

T o ensure a higher level of security, please change the default login details when first logging into
Freedom Fone.

If you cannot login with these details, contact your Freedom Fone administrator for up-to-date login
information.
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INCOMING SMS
T he SMS service allows you to receive ordinary SMS messages and view them in a reader friendly
interface. T hrough the Freedom Fone interface you can then export the SMSs into any content
management service of choice. Freedom Fone does not have the functionality for you to send SMSs.
T here are already several tools available to send SMSs effectively and integration with one of these
tools, FrontlineSMS, is on the Freedom Fone agenda for 2012.

A caller may send an SMS to one of the SIM cards that you have installed for your Freedom Fone service.
Freedom Fone first checks to see if the SMS received begins with a keyword that has been reserved for a
poll. If this is not the case, the SMS will appear in your Message Centre under Incoming SMS.

In Message Centre > Incoming SMS, all SMSs are sorted by date/time that they were received, and also
display the message content, time, type, and sender's number. From here, you are also able to delete
single or multiple messages.
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POLLS
A simple and fast way to measure opinion on an issue is to conduct SMS-based polls. SMS polls enable your
callers to respond to a structured question via an SMS response. As the SMSs arrive on the Freedom
Fone system the individual SMSs are tallied and a summarized tabular output is generated. In scenarios
which need urgent action but yet rely heavily on evidence-based information to take the first step, SMS
polls can be a powerful and effective tool.

FUNCTIONALITY

T he Poll function allows end users to participate in polls by sending a SMS to Freedom Fone. T he Poll
functionality allows for time sensitivity, providing a start and end date/time, and multiple choices for a
user to select from. T he polls are available at Poll > Manage Polls.

Poll details can be communicated with the public via any means, including website, email, radio and
printed materials. Remember to share the above details and include the poll code and the phone number
to which participants should send their SMS replies. You can refer to the chapter about advertising your
service to get some ideas on how to spread the word out about your poll. 

For each poll, once it has started, the administrator can at anytime, view the interim or final result in
terms of number of votes per answer, and percentage of total votes per answer. 

T he system classifies all incoming votes as valid, invalid, or incorrect:

VALID VOTE

A vote is said to be valid if received with the correct poll code (the poll code is the unique identifier of the
poll - see further) and a valid answer (the participant's answer matches one of the options given). A valid
vote can be in time, but also early or late:

Early 
Received before the poll opened.
In time  
Received while the poll was open.
Late  
Received after the poll was closed.

Early votes will be registered as “Valid, early”. T he number of early votes per poll option is presented in
a separate column under the View poll page. Early votes will not be added to the T otal votes accepted
for the poll.

Late votes will be registered as “Valid, late”. T he number of late votes per poll option is presented in a
separate column under the View poll page. Late votes will not be added to the T otal votes accepted for
the poll. 
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T he Early and Late vote classifications are summarised separately to provide a complete view of votes
submitted to the poll concerned.

INVALID VOTE

A vote will be classied as "invalid" if it displays the correct poll code, but a non-matching poll option (the
participant used the correct poll code, but his answer was not one of the options given.)

Invalid votes are registered as votes, but classified as “invalid”. “Early”, “late” and “on-time” invalid votes
are also registered. 

Only “on-time” invalid votes are incorporated into the T otal number of votes summary.

Invalid vote totals are provided to give you an idea of how SMS errors might impact on poll results.

INCORRECT VOTE

Incorrect votes have a non-matching poll code.

Incorrect votes that cannot be matched to any existing poll, will be classified as an incoming SMS and will
be stored under “Other SMS”. T he SMS will be classified as “Unclassified”.

OTHER CRITERIA USED FOR VOTE VALIDATION

T he poll is not sensitive to casing, so 'yes' ,'Yes', 'YES', 'yEs' will all be interpreted as a YES. T he same
logic applies to the poll code. More than one poll can be active at the same time. Incoming SMS are
identified by the code used and matched with existing polls.

T he timestamp used to determine whether or not a vote is in time for a poll, is the time of arrival to the
Freedom Fone platform. Hence, if an SMS gets delayed in the GSM network, it will be classified as late
even if it was sent before the poll deadline.

CREATE A POLL

T he Freedom Fone administrator has the ability to create, edit and delete Polls. A poll is composed using
the following parameters; to create a poll navigate to Polls > Create Poll and you should see the screen
shown below:
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A Poll consists of the following:

Questio n 
T he question you want your audience to answer.
Co de  
T he poll code. It cannot comprise more than 10 alphanumeric characters. T his code must be
included as the first word in an SMS vote participating in the poll.
Answers  
T wo or more answers to the question. For example the question might be "Does your family make
use of mosquito nets?" Your valid answers would then be "Yes", "No" or "Sometimes".
Start time  
Date and time when the poll opens for submission.
End time 
Date and time when the poll closes for submission.

Example: T he administrator creates a poll with the following parameters:

Question: Would you like to deploy Freedom Fone in your organization? 
Code: freedomfone 
Answer: Yes/No/Maybe 
Start time: 08:00 AM, January 1, 2010 
End time: 08:00 AM, Jan 31, 2010

T o participate in the poll, the end user needs to send an SMS that arrives after 08:00 AM the 1st of
January, and before 08:00 AM the 31st of January 2010 with one of the following messages:
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freedomfone yes 
freedomfone no 
freedomfone maybe

T he administrator can at any time edit the above listed fields. Of course, it is not recommended to
change the question, code or answers to a poll once it has been opened to the public. Before a poll is
opened, and after it has been closed, no poll votes are registered for the poll. 
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LEAVE A MESSAGE (LAM)
T he Leave-a-message or LAM function is an effective way of establishing two-way communication with
your callers. With the Leave-a-message function the caller can leave a question or comment in audio form
on your Freedom Fone system. Audio messages enable your callers to express themselves more freely
and Freedom Fone captures those messages without loss of meaning or character. T he content left by
your callers can be played and listened to from the Freedom Fone interface. In addition to being a
platform for leaving questions, the Leave-a-message function can be useful as an alert platform for callers
to alert you on issues that need your attention. Content left by callers can also be re-used, for example
you could select 5 stories submitted for a competition using LAM, re-broadcast these and allow the public
to vote for their favourites.

FUNCTIONALITY

A Leave-a-message function can be either a part of a Voice Menu or it can be a stand alone service. As part
of a voice menu the Leave-a-message function will be allocated a digit by the Freedom Fone
administrator, which a caller can dial to access it. When the Leave-a-message is set up as a stand alone
service, the caller will be directly connected to the service without dialing any key and they can record a
message after hearing a beep and then hang up.

T he advanced Leave-a-message service allows the caller to:

1. Record a message
2. Listen to their recorded message
3. Delete and record a new message OR
4. Save their message and exit
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By using the buttons # (hash), * (star), 0 (zero) and 1 (one), the user is able to navigate through the menu
according to the illustration above.

T he caller's selection after leaving a audio message determines whether the simple or advanced
functionality is used by the system. If they hang up directly after leaving a audio message, the message is
saved; if they press the # key after leaving their audio message, the system will await further key
selections to determine what should be done with the audio message. If they fail to select 1 to save their
message before hanging up (having pressed #), their audio message will be deleted.

Callers’ audio messages are displayed in the Leave-a-message Inbox.

THE LEAVE-A-MESSAGE INBOX

Visiting Message Centre > Inboxes > Audio Messages will provide you with access to all of the Audio
Messages left in the Leave-a-message inbox. Callers’ audio messages can be titled, tagged, categorised
and rated. T hey can also be archived if required – in message edit view the status field can be used for this
purpose. Each audio message can be exported as an .mp3 file using the download icon .
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CREATING A LEAVE-A-MESSAGE MENU

Message Centre > Manage LAM and click on the Create New button.

If you wish to make use of the Advanced Leave-a-message prompts, click advanced options at the bottom
of the screen, above the Save button. You will need to provide the following audio files:

Instructio ns : T he instructions file specifies the instructions the caller has to execute to review
their message.
Invalid: T he invalid-sound attribute specifies the message that is played when a caller makes an
invalid entry.
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Go o dbye : T he Goodbye message is played when a caller makes too many invalid entries or too
many timeouts occur. T his file is played before disconnecting the caller.

Saving this will create your Leave-a-message which can now be linked to from your Voice Menus.
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VOICE MENUS
Voice menus enable you to create an information tree which your callers can navigate through with the
aid of dialing keys on a telephone keypad. You can imagine a voice menu as a grouping of similar content
which you would like your callers to access. Each content item in your menu will be linked to a unique
digit on your telephone keypad.

T he process of embedding voice menus within existing voice menus, which we call nesting, allows you to
extend your information tree and hence provide more content to your callers.

FUNCTIONALITY

T he administrator is able to build a variety of Voice Menus based on customised audio files and
synthesized text messages called content.

A voice menu consists of:

Menu Instructions 
A set of mandatory voice prompts which include:

Welcome message 
T he welcome message specifies the initial greeting that is played when a caller reaches the IVR.
T he welcome file will be played only once when a call is first answered by the system. An
example would be "T hank you for calling ABC company"
Instructions 
T he instructions file specifies the instructions the caller has to execute to listen to the menu
options. T his file will be played out to the caller repeatedly at various points of the call. An
example would be "For issues on domestic violence, press 1; to leave a message, press 2, ...etc".
You can refer to the chapter "create voice menu" to get tips on how to make your instructions
efficient.
Invalid 
T he invalid-sound attribute specifies the message that is played when a caller makes an invalid
entry.
Goodbye 
T he Goodbye message is played when a caller makes too many invalid entries or too many
timeouts occur. T his file is played before disconnecting the caller.

Menu Options 
A menu option can be made up of the following which your callers can select on the telephone to
hear the content:

Content
Leave a Message
Voice Menu
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T he design of a Voice Menu is illustrated above.

DESIGNING A MENU

When creating a voice menu, the best practice is to sketch out the intended structure for how you wish
users to navigate your content.
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MENU 1.

WELCOME AUDIO

"Welcome to Local News FM"

INSTRUCTIONS

"To listen to info from your area, press one

To listen to global news headlines, press two

To leave us a message, press three"

CALLER PRESSES 1.

MENU 2.

INSTRUCTIONS

"To get traffic info, press one

To get local weather, press two

To return to the previous menu, press zero"

CALLER PRESSES 1.

CONTENT AUDIO

"Todays traffic...."

CALLER PRESSES 2. 

CONTENT AUDIO

"Todays weather is...."

CALLER PRESSES 0.

USER RETURNS TO PREVIOUS MENU

CALLER PRESSES 2.

CONTENT AUDIO

"Todays global headlines are...."

CALLER PRESSES 3.

CONTENT AUDIO

"Please leave us a message after the tone"

INVALID AUDIO

"Oops, please enter a valid option"

GOODBYE AUDIO

"Goodbye"

CREATING CONTENT

Once you have designed the structure of your menu, it is time to create the audio files.

T he audio files must be uploaded in either .mp3 or .wav format through the user interface. T hey should
be recorded as mono, 8Khz files, and must be less than 10MB in size. Once uploaded, they can be listened
to from the administration GUI via the built-in Flashplayer. Audio files can at any time be overwritten with
a new audio file.

Once you have created the menu instructions, record the menu options and upload them in the content
section, IVR Centre > Content > Upload.
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Give your audio file a title and save.

When all audio content has been uploaded, you are now able to find it in IVR Centre -> Content.

CREATING THE VOICE MENU

When creating an voice menu with sub menus, you must create all sub menus before creating their
parent. T his will become apparent when putting them together as you need to link to an existing menu.

T o create a Voice Menu, follow these simple steps:

1. You will need to create the menu structure at IVR Center -> Voice menus -> Create New
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2. Name the menu, and then assign the audio files you have just created to the four respective
sections.

3. Within the Menu Options select the type you wish to appear for the assigned digits.
4. In the example above, we have to create MENU 2 before we create MENU 1. When creating MENU

1, we can select MENU 2 in the Voice Menu dropdown selection for digit #1. And then select the
appropriate audio Content for digit #2. Finally selecting your Leave a Message for digit #3 (Please see
the Leave a Message chapter on how to create your Leave a Message menu).

5. Save, and you're finished!

All existing Voice Menus will now appear in IVR Center > Voice menus

AUDIO FILES IN DEPTH

T his section helps to provide you with a bit more about the audio files within Freedom Fone, and other
approaches to creating menus.

A Menu Instruction can be generated in three ways:

1. Customised audio files
2. Customised text to speech
3. Default text to speech

Customised audio files: If the administrator associates an audio file with a message, that file will be
played to the caller when she enters the voice menu.

If an audio file has been uploaded to the voice menu, it can be exported as an .mp3 file by clicking the
download icon .

Customised text to speech: If no audio file is provided for a message, but a customised text message
exists, the text message will be synthesized and played to the caller.

If the voice menu includes one or more text prompts in the place of audio files AND you are NOT  using a
licensed copy of the default Cepstral voice, you will hear an automated voice play before each text
prompt is synthesized, reminding you to buy a license. If you use your own audio files you do not need to
use text to speech at all.

A license for the Allison 8 Khz voice for Linux can be bought from https://www.cepstral.com/. Once you
get the license you can register the voice by running the swift executable from the command prompt as
follows:

Open a terminal window by clicking the terminal icon in the centre of the title bar at the top of your
screen.
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At the prompt type

/opt/swift/bin/swift --reg-voice

Follow the instructions to enter the details associated with your license. You will be asked for
Name, Organisation and License key

Default text to speech: If neither an audio file, nor a customised text is provided, the default text will be
synthesized and played to the caller.

A Menu option file can be used in one or more different Voice Menus. T hese files cannot be deleted if they
are currently associated with a Voice Menu. T he administrator can at any time add, edit or delete a Voice
Menu. T he administrator can create multiple Voice Menus and all can be active at the same time. Freedom
Fone v.2.S offers the possibility to assign eight Menu Options to a Voice Menu. It is possible to link voice
menus such that a menu option can lead to another voice menu which in turn gives more options to a
caller.

Note that digits 0 and 9 are reserved for navigation.
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SECURITY
T elephony is inherently insecure - carriers (Mobile Network Operators) maintain call data records of
phone call and SMS traffic on their networks. T his enables authorities to monitor the phone numbers
accessing a Freedom Fone Service and to scrutinise the contents of SMS messages.

Greater risk to caller privacy is more likely to be found inside your own organisation since sensitive
information about your callers is recorded by Freedom Fone, for example:

Pho ne  numbers  are displayed for Incoming SMS and Voice messages received via the Leave-a-
Message function
Callers ' co ntent cho ices  and activity is revealed in system data and Call Data Records
Pho ne  bo o ks  can be used to associate a personal profile for callers' numbers
Expo rt butto ns  allow pretty much all of the data to be exported from Freedom Fone in one form
or another.

T o help you limit which of your staff can view and export sensitive data, there is a basic Role Based Access
Control in the Freedom Fone's user interface. All users of the system must enter a username and
password in a login screen.

For some organisations, there are very real concerns that their Freedom Fone server might be seized by
hostile agents with the skills to bypass basic security, potentially compromising their callers. In
recognition of this possibility, Freedom Fone's logging architecture has been reorganised to allow
sensitive data to be stored in an encrypted drive and/or on removable media. For more information about
using this service contact us - refer to the chapter Support

For environments where security is a concern the sweeper is a useful feature which allows you to replace
sensitive data that is visible with dummy data. Such information includes caller phone numbers, names,
email addresses, Skype id's and organisational names. T he security feature will remove these from all
user interfaces and log files.

The  sweeper f unctio ns  sho uld be  used with care  as  it is  irrevers ible  and will render
many o f  the  usage  repo rts  meaningless . Fo r advanced users , the  Backend Sweeper can be
co nf igured to  perio dically purge  sens itive  inf o rmatio n f ro m Freedo m Fo ne .

FRONTEND SWEEPER

T he Frontend GUI Sweeper is a panic button that is used to replace all caller identity information with
arbitrary values. It is only accessible for Admin system users through the main menu (User Management >
Frontend Sweeper). It is important to note that once you have run the Frontend sweeper it is not possible
for you to view or reverse the process. It is advised that you have a system in place to regularly backup
your data.

RUNNING THE FRONTEND SWEEPER

Navigate to User Management > Frontend Sweeper

When you select the Frontend Sweeper button you are brought to the screen shown below.
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Click on the Start Sweeper button and all personally identifiable information associated with the records in
the Call Detail Records, Monitoring, Reporting, Statistics and Phone book details will be replaced. T he
screen shot below shows how the callers' numbers associated with the call data records are replaced
with 555666.

T he screen shot below shows how the contact details in your Phone books are anonymized by the
sweeper, replacing name, surname and email with John Doe as the caller.

69



BACKEND SWEEPER

T he Backend GUI Sweeper is a service that runs behind the scenes to remove caller records and logs from
the system at regular intervals. It is accessible to anyone with root access to the machine, and is
automatically run by means of a cronjob. T he Backend GUI Sweeper is not enabled by default
(cron/crontab). T he Backend Sweeper will periodically, depending on settings, purge sensitive information
from Freedom Fone.

CONFIGURATION

T he Backend sweeper is configured in the file config/gui_config_sweeper.php 

T he following parameters can be configured:

1. Enable/disable Frontend sweepers 
Values: 0 or 1 
Comment: Enable GUI sweepers by setting value to 1. 
Disable GUI sweepers by setting value to 0.

2. Sweeper mode 
Values: low or high 
Comment: "low" mode will only sweep phone numbers, while "high" mode will also sweep callers
names, surnames, email, Skype and organisational names.

3. Fallback data 
T he fallback values (after sweeping) of callers numbers, names etc. can be configured under
SWEEP_SETTINGS. T he default value for caller's name is for example "John Doe".

CORE SWEEPER

T he Core Sweeper handles the following operations (none of them is enabled by default as a cronjob):
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1. Sweeps audio meta data of MP3 and WAV files 
Documentation: sweeper/INSTALL.sweeper.metadata

2. Extra log information 
T he script sweeper/sweeper.sh allows a user to re-configure the system to disable syslog, mail,
webserver and telephony logs. T he script replaces the configuration file of iwatch, apache2,
freeswitch to disable logging. 
Documentation/Script: sweeper/sweeper.sh

3. Delete all logs 
All logs are stored under /opt/freedomfone/log. T he script sweeper/sweeper.sh will prompt to
delete all logs. Alternatively a cron job can be created to delete the logs periodically. 
T he function delete_logs() in the script shows how to stop and start the services.
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STATISTICS
T he power of Freedom Fone statistics is that they will capture every detail from the time a caller dials
your number to the point at which they end the call. T hey offer more insight into the information needs
of your callers and can be useful in coming up with a content strategy.

It is  highly reco mmended that yo u do  no t wo rk directly o n the  Freedo m Fo ne  server to
view Call Data Reco rd repo rts  and graphs . These  activities  require  intens ive  database
activity that will s lo w do wn perf o rmance  o n the  server. Whenever po ss ible , rather
access  the  Freedo m Fo ne  server f ro m ano ther co mputer us ing yo ur lo cal area
netwo rk.

Statistics can be exported as a CSV file for a refined analysis or for building graphs, for example using our
Graphic Reporting T ool (described later in this chapter) or a spreadsheet tool like Excel.

T he statistics come under the System Data menu and consists of 4 sections.

CALL DATA RECORDS

Call data records, commonly abbreviated as CDR, detail when a call starts and when it ends. T he CDR
also records when a SMS and a Poll lands. T he IVR menu or LAM that a caller accesses is also reflected in
the CDR. T he administrator can choose to export All entries, or a range of entries using a start and end
time. T he screen shot below shows an example of a CDR page. T o see the CDR page navigate to System
Data > Call Data Records:

T he CS_ROUTING label under the "T ype" column indicates the start of a call and the CS_DESTROY indicates
the end of a call. each call has a unique Call ID which is generated by the system. For every call there are
two entries,one indicates the start and the other the end.
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STATISTICS

T he statistics page gives a summarised view of all the activities that are happening within your system.
T he view of the statistics page is similar to the overview section of the home page, the difference being
that on the statistics page you can select a date and time range to view statistics. T o view the statistics
page navigate to System Data > Statistics. T he screen below shows the statistics page.It is not possible to
export this page.

MONITORING

Freedom Fone offers the administrator a means to monitor the features accessed by callers via a voice
menu. For each incoming call to a Voice Menu, the caller's options are recorded (time, ivr, digit pressed,
menu option chosen, caller number). T hese call records can be exported to a CSV file. T he administrator
can choose to export All entries, or a range of entries using a start and end time. T o view the monitoring
page, select System Data > Monitoring. T he screen shot below shows the monitoring page:
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Entries that relate to a Leave-a-message will only reflect in the monitoring section if the leave-a-message
is an option of a voice menu. 

REPORTING

T he reporting page shows the call duration for the calls made to either your voice menu or your leave a
message service. You are able to select a date range for which you want to view either your voice
menus or leave a message service. T he administrator can choose to export all entries, or a range of
entries using a start and end time. T o access the reporting page, select System Data > Reporting. T he
screen shot below shows the reporting interface:
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GRAPHIC REPORTING TOOL

T he Graphic Reporting T ool enables you to output graphical representations of the data from your call
detail records. T his tool can be of great value for presentations, and for simplifying and making sense of,
the call statistics you get on your machine.

First, you need to export the data you wish to show in your graph. T o do this, go to System Data >
Reporting, select the search parameters according to the information you wish to present - choose the
relevant dates and service. Click on the export button and ensure that only the comma check box is
selected in the export attributes of the CSV file. Choose the location for the export file and save.

T o access the graphic reporting tool, open a new tab and into the address bar of the browser, type in
the following URL:

a) If you are working on the Freedom Fone server: 
http://localhost/reporting

b) If you are accessing the Freedom Fone server across the LAN: 
http://your FF server IP address/reporting

e.g. http://192.168.1.250/reporting

After entering the URL above, you should get the following screen:

Using the Browse button, navigate to the CSV file you have exported from Freedom Fone. Click the Upload
button to view the page below: 
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Select the menu(s) and date ranges you want included in the graphs and give the report a title. Click on
the Generate Report button and a new report should be generated with various graphical output, as
illustrated by the screens below:
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Use the buttons on the left hand side of this page to view different graphical representations of your
data.

Cumulative Menus display call data records totaled over time.
Unique Menus detail calls per time period selected ie total calls per day/week/month
Unique Vs T otal differentiates between unique callers and the number of calls they make
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T his data can be exported and printed.
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USER MANAGEMENT

SYSTEM USERS

Freedom Fone version 2S adds the functionality of multi users with different access levels.

T he system administrator has unrestricted access to all the system modules. You can have many users
with administrative rights, the same applies to the non-admin users.

T o add a user simply navigate to User management > System Users and click on the Add user button shown
in the screen below.

When you click the Add user button you are prompted to create a new user: assign a username and
password of your choice to the new user and lastly assign the new user with either Admin or non-Admin
rights using the group option. T he image below shows the interface for adding a new user. 

Click on the Save button. You can see that the new user had been created.
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PHONE BOOKS

CREATING PHONE BOOKS

Phone books can be used to segment your callers, for example for different calling campaigns.

ADDING CALLERS TO YOUR PHONE BOOK

You can populate your phone book in Edit mode. Select one or more callers from the dropdown list
displayed and save. Alternatively you can add callers to the phone book from the User Management >
Callers page.

REMOVING A CALLER FROM A PHONE BOOK

Do not select the delete option as this will remove all instances of that caller, including from the caller's
list!

You may remove a user in two ways:

Edit phone book (and uncheck the caller) or,
Edit caller (and uncheck the phone book).

EXPORT PHONE BOOK

You can export your phone book(s) to a CSV file by selecting the Export icon associated with it.
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CALLERS

ADDING A CALLER

You can manually add a caller by selecting the Add Caller button on the User Management > Callers page.

On the User Management > Callers > Edit page you can edit caller details and view caller's activity and
details.
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V ersio n  2 S7  &  2 S8  u p d a te
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VERSION 2S7 & 2S8 OVERVIEW

WHAT'S NEW?
SMS sending via OfficeRoutes, Huawei dongles and Clickatell Bulk SMS gateway
T he new 'SMS Centre' menu option brings SMS sending and receiving under one menu - the
original 'Message centre' is now exclusively for voice messages and LAM IVR
SMSs can either be received into one global Inbox or separated into a different Inbox for each sim
card
SMSs can be received via multiple OfficeRoute devices
Improved Hardware management

New USB dongle detection and management wizards/scripts
New Dashboard →Service Mapping option for connecting voice enabled dongles to IVR menus. No
need to edit configuration files if you add additional Leave a message IVRs or other IVRs. 
T he Dashboard → Active GSM channels page will now show details for multiple connected
OfficeRoute devices 
Dashboard → GSM channels page renamed to Active GSM channels and now displays additional
device information

T he Graphic Reporting tool has been integrated into the System data menu as System data → Call
graphs
Additional security for OfficeRoute devices has been added in the form of an optional firewall
whitelist
Logs are now displayed in descending chronological order
Def ault user and passwo rd f o r FFv2S7 and FFv2S8 servers  are : 
user: sharicus 
password: sharicus

WHAT ELSE HAS BEEN IMPROVED?
We've updated the development framework to CakePHP v2.4
Fixed a variety of bugs
Clarified the normalization settings required for the OfficeRoute
We've written a Developer's guide that covers additions and improvements made in FFv2S7.
Download the latest version of the Sharicus_2S7_deve lo per_guide  from
www.freedomfone.org/page/documentation

DIFFERENCES BETWEEN FFV2S7 AND FFV2S8
FFv2S7 runs on Ubuntu 12.04LT S. Ubuntu 12.04LT S will be supported by Ubuntu with updated drivers
until 2017.
FFv2S8 runs on Ubuntu 14.04LT S. Ubuntu 14.04LT S is Ubuntu's latest long term support release.
Since this release was only made available in April 2014 there may be bugs in the operating system
for some months to come. T ry this version first. If Ubuntu bugs give you problems, revert to
FFv2S7.

T here are so many improvements we urge you to move onto either v2S7 or v2S8! Unfortunately there is
no upgrade script (sorry!) so you will need to make a note of your statistics, export any important data
for archive purposes and do a fresh install.
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THE SMS CENTRE
T he new SMS Centre menu provides links to all SMS related actions. 

 

RECEIVING SMS - INBOXES

By default, all SMSs received will be displayed in descending chronological sequence on the Incoming SMS
page. You can use the Channel dropdown selector to filter SMSs based on the channel associated with
each sim card registered with the Freedom Fone server over time. Even if a device is later removed, the
channel originally associated with it will remain as an option within the Channel filter list.
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Filtered messages will look as follows: 
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T o redisplay all SMSs, select '- Channel -' from the Channel selector. 

SMS MESSAGES RECEIVED VIA THE OFFICEROUTE

We provide configuration files for the OfficeRoute to help you set the device up for use with Freedom
Fone. Make sure your OfficeRoute firmware is updated to v2.3.22 using the OfficeRoute Administration →
Update page before trying to load our configuration files. You can view the current firmware version on
the OfficeRoute Network page under System Information. 

 

AGGREGATE SMS MESSAGES INTO ONE ADMIN INBOX

Upload backup_officeroute_2.3.22_140614.tgz using the OfficeRoute Administration → Configuration Backup →
Upload config page if you want to aggregate SMSs into one Admin Inbox for all sim cards in the
OfficeRoute. 
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AGGREGATE SMS MESSAGES INTO DIFFERENT INBOXES FOR EACH SIM CARD

Upload backup_officeroute_2.3.22_multiSMS_outSMS_140614.tgz using the OfficeRoute Administration →
Configuration Backup → Upload config page if you want to separate SMSs into different Inboxes for each
sim card. 

 

For more information on setting up the OfficeRoute for SMS receiving, please see the latest version of
the Sharicus_2S7_deve lo per_guide .

SMS MESSAGES RECEIVED VIA HUAWEI DONGLES

USB dongles can be set up in 3 different ways using the Hardware Wizards. 

a. To  Rece ive  vo ice  calls  & rece ive  SMSs

T he dongle will be displayed as a GSMOpen device on the Dashboard → Active GSM channels page. T he
Interface name (Channel) will be prefixed by FSn- 
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b. To  o nly rece ive  SMSs  
T he dongle will be displayed as a Gammu device on the Dashboard → Active GSM channels page. T he
Interface name (Channel) will be prefixed by GMn-

c. To  rece ive  and Send SMSs  
T he dongle will be displayed as a Gammu device on the Dashboard → Active GSM channels page. T he
Interface name (Channel) will be prefixed by GMn- 

T o redisplay all SMSs, select '- Channel -' from the Channel selector.

For more information on the Hardware Wizards and setting up Huawei dongles for SMS receiving, please
see the latest version of the Sharicus_2S7_deve lo per_guide .

SENDING SMS MESSAGES

SMSs can be sent using the following channels: 

Clickatell's Bulk SMS Gateway
OfficeRoute SIP gateway
Huawei E173 and E1550 dongles

SMS GATEWAYS -  CLICKATELL

Visit https://www.clickatell.com/register/ to set up a Developers' Central account. Don't forget to add
credits to your account. Make a note of the following: 

Clickatell's API URL - should be api.clickatell.com
Clickatell username
Clickatell password
Clickatell API key

Create an SMS Gateway for your Clickatell Developers' Central account in Freedom Fone using SMS
Centre → SMS gateways. Click the Create new button in the top right hand corner of the page.

You will be presented with a form to complete for the SMS gateway. Enter the details provided for your
Clickatell account. 
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Read more about Interfacing with Clickatell in the Sharicus_2S7_deve lo per_guide . 

SMS GATEWAYS -  OFFICEROUTE

See the latest version of the Sharicus_2S7_deve lo per_guide  for instructions on how to set up the
OfficeRoute for sending SMSs. T he Sharicus_2S7_deve lo per_guide  will also show you how to update
the necessary Freedom Fone and Postfix configuration files.

Please also check your OfficeRoute Normalisation settings against the information provided in the latest
version of the Sharicus_2S7_deve lo per_guide .
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Firewall: If your OfficeRoute is connected to the Internet it is recommended that you use the new
Firewall Wizard to protect yourself from VoIP spammers. For more information on setting up your
firewall and whitelist see the Sharicus_2S7_deve lo per_guide .

SMS GATEWAYS -  HUAWEI DONGLES

We have only tested the Huawei E173 and E1550 dongles with Freedom Fone. See the latest version of the
Sharicus_2S7_deve lo per_guide  for instructions on how to use the Hardware Wizards to set up your
Huawei dongle for sending SMS. 

Note that a dongle cannot be used for voice and SMS sending. It must be designated for one or the other.
Dongles are able to receive SMS regardless of whether or not they have been set for voice or SMS
sending. 

CREATE SMS BATCH

T o send SMSs to one or more recipients, create a plain text document with one phone number per line.
Do not end each line with any form of punctuation.

Go to SMS Centre → Create batch to send your message. 
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Name: Provide a descriptive name for the outbound SMS for administrative purposes. 

SMS body: Enter your message text here. Max 160 characters 

Sender number: T his field is only used for Clickatell accounts. Enter the phone number you have
registered with Clickatell for sending SMSs. Do not add any country prefix to the number. 

Receivers: Browse for the text document that contains the phone numbers for your SMS recipients. 

Select sending method: Valid options are 

SMS Gateway 
Use this option if you're sending via Clickatell
GSM Channel 
Use this option for OfficeRoute and Huawei dongles 

Once you click the Save button, Freedom Fone will attempt to send your message to your recipient list.

VIEWING SMS BATCHES AND DELIVERY STATUS

Go to SMS Centre → SMS Batches to view details of SMSs sent. Click the hand icon to view details of SMS
batch recipients and the delivery status associated with the message sent to each recipient.

Note that delivery status messages are currently only available for SMSs sent via Clickatell and dongles.
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IMPROVED HARDWARE MANAGEMENT
Now that we have added SMS Sending, providing tools to assist with device management has become a
priority. T he challenge is actually with detecting USB GSM dongles and configuring them correctly.

BUYING USB GSM VOICE ENABLED DONGLES - SOME ADVICE

We have tested Freedom Fone with Huawei E173 and E1550 dongles. These dongles must be unlocked and
voice enabled. 

We have come across variations of these dongles which have the same or very similar model numbers
but which have voice functionality disabled and do NOT  work with Freedom Fone. Before you buy one of
these dongles get the seller to confirm that they are unlocked and voice enabled.

DC-Unlocker is a useful free utility that can be used to detect a dongle's settings/features - Download a
copy from https://www.dc-unlocker.com/downloads.

CONFIGURATION OPTIONS

It is possible to configure: 

One or more OfficeRoute devices to send and receive SMSs and receive phone calls
One or more Huawei dongles to send and receive SMSs only - this configuration is managed by an
application called Gammu
One or more Huawei dongles to receive SMSs and phone calls - this configuration is managed by
an application called GSMOpen

It is not currently possible to configure a USB GSM dongle to handle incoming calls and send SMSs.

T he Hardware Setup Wizard will associate your device(s) will the relevant applications based on your
answers to the questions asked.

93

https://www.dc-unlocker.com/downloads


HARDWARE DETECTION AND SETUP OF USB GSM DONGLES 

T o assist with the complexity of managing and configuring USB GSM dongles, we have developed new
guidelines and provided 2 new scripts.

For full details on how to use the Discovery & Setup Hardware Wizards please see the latest version of
the Sharicus_2S7_deve lo per_guide .

If things have become confused and you want to reset all Freedom Fone references to telephony devices
in the system (as displayed on Dashboard → Active GSM channels and Dashboard → Service mapping pages
in the Freedom Fone user interface), see Reinitialis ing te lepho ny device  detectio n settings  in the
Sharicus_2S7_deve lo per_guide .

Map device  to  service  
If you have configured one or more USB devices for Voice services (FreeSWIT CH), you must map them to
a voice service (IVR or LAM). Under Dashboard → Service Mapping, you can select an IVR or LAM for each
voice-configured USB device. Once you have selected the services of your choice, you must press the
'Create Dialplan' button, and the FreeSWIT CH dialplan will be updated with your choices

Test yo ur devices  
If things don't work as you expect, it may be that key services like FreeSWIT CH, the Dispatcher or
Gammu daemons haven't been restarted. T he easiest thing may be to restart your server and run your
tests.

Tro ublesho o ting USB do ngles  
See Tro ublesho o ting do ngle  settings  in the Sharicus_2S7_deve lo per_guide .
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OFFICEROUTE SIP SECURITY OPTIONS
Sadly, there are bad folks out in the world who try to take advantage of unprotected VoIP gateways to
make free phone calls. 

T he default policy of Freedom Fone is to only allow authenticated SIP calls. However, in order to allow
unauthorized users to call into Freedom Fone via SIP (which is free of charge and only requires an
Internet connection), we have implemented a solution to facilitate this. 

Furthermore, to block VoIP scanners and other unsolicited traffic hitting the platform, we have
implemented a firewall that blocks unwanted traffic. For more information on setting up your firewall and
whitelist see the Sharicus_2S7_deve lo per_guide . 
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REPORTING – GRAPHICS REPORTING
TOOL

 

T he Graphic Reporting tool, contributed by Olaf Dunn, has been integrated into the System data menu as
System data → Call graphs. T o export data for Call graphs, use reports generated by System Data → Call
detail report.
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T ech n ica l  Stu ff
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TECHNICAL REQUIREMENTS
Freedom Fone was built as a DIY (do it yourself) tool which you should have up and running before you
finish saying "Freedom Fone". T here are a few technical requirements you have to satisfy before you
start using Freedom Fone. T he requirements stated below are only given as a guideline. You may see the
need to increase your equipment specifications depending on the amount of calls you expect to average.

EVALUATION EQUIPMENT REQUIRED

If you wish to evaluate Freedom Fone beyond experimenting with our online demo
(http://demo.freedomfone.org), we have successfully installed on low end/low cost computers for non-
critical demonstration and evaluation purposes.

An example minimum specification of a computer that is able to run this version of Freedom Fone:

Co mputer Mo del: Asus Eeepc 900HD 
Pro cesso r: Intel Celeron M 900MHz 
RAM: 1GB 
Hard Drive : 10GB 
Optical Drive : DVD Reader

Please note: if you wish to install Freedom Fone to test you should do so on a machine which contains
no important data as the installer will wipe your hard disk and install both the Ubuntu Operating system
and Freedom Fone. As an alternative, you can choose to install Freedom Fone into another partition on
your computer's hard drive. Freedom Fone's installer DVD will give you an opportunity to choose
between overwriting the entire hard drive and installing alongside your current system.

RECOMMENDED EQUIPMENT REQUIRED

When it comes to implementing your Freedom Fone service in a live environment, it is highly
recommended that you use a more powerful system. T he following is a recommended standard set up:

Pro cesso r: Dual Core Processor (Intel or AMD) 2.0GHz+ 
So und: Onboard soundcard 
RAM: 2GB 
Hard Drive : 80GB 
Optical Drive : DVD Reader 
GSM device : 2N OfficeRoute (takes 4 SIM cards) o r Eurodesign MobiGater (takes 1 SIM
card) 
Signal: Good GSM signal coverage 
Po wer: Reliable backup power

See the Equipment chapter for details of suppliers of OfficeRoute and MobiGater devices.

No te : Freedo m Fo ne  do es  no t run o n Macinto sh hardware .

T he schematic diagrams below show the different configurations you can have with equipment listed
above.
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T he diagram above shows how you would connect a computer running Freedom Fone to an OfficeRoute.
Note that you can also connect the OfficeRoute directly to your Freedom Fone computer using a
crossover cable.
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T he diagram above shows how to connect to the MobiGater.
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INSTALLING THE SOFTWARE
As a start, whether you just want to try and evaluate Freedom Fone or install it for good, the first step
for you is to get a proper Freedom Fone installation DVD. For that, you can either download the
software as an ISO file from the Freedom Fone website www.freedomfone.org/downloads or, if you
have bandwidth constraints, you can request the DVD to be sent to you directly by Freedom Fone. Just
send an email to info@freedomfone.org!

If you choose to download the software, you need to burn your Freedom Fone installation DVD. T o do
so, remember that ISO files are disk image files: do NOT  try and 'file copy' the image directly to a DVD -
it must be written as an image file to the DVD. Use the Record a disc from disc image feature from your
disc burning software.

... Got it?

GETTING STARTED...

Note: before you start using the DVD, we recommend you back up your computer as a common security
procedure.

Once you have your Freedom Fone installation DVD, just insert it into the DVD drive of your computer
and reboot your machine. T he system will boot from DVD and the screen below will appear, displaying
different options you have to get started with Freedom Fone:
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EVALUATING FREEDOM FONE

If you only wish to play around with Freedom Fone, without installing the software, just do not do
anything when the above screen pops up. T he LiveCD option is the default option and it will automatically
go into live mode - you might have heard someone mention "running a system live": this simply means
running the software from the installation media - such as a CD/DVD - without installing it on your hard
drive.

You can then play with the Freedom Fone interface in the live mode, and when you are done shutdown
and eject the DVD.

Please always remember that the LiveCD option does no t install Freedom Fone permanently to the hard
drive.

INSTALLING FREEDOM FONE

T o install Freedom Fone, select the option which lets you install on your hard drive: install - start the
installer directly and press the Enter key. T hen follow the steps below.

T his procedure will install both the Ubuntu Operating system and Freedom Fone on your computer.

Impo rtant warning: remember that Freedo m Fo ne  is  a system replacer which requires
a dedicated co mputer; the  installatio n will erase  f ro m yo ur hard disk yo ur existing
o perating system, to gether with all yo ur data. Make  sure  yo u have  backed up yo ur
impo rtant data bef o re  yo u start the  installatio n pro cedure .

INSTALL PROCEDURE

Please note that during the installation process, the system might take some time to move on between
each screen; this depends on the hardware specifications of your computer.

SCREEN 1

T he first screen that comes up prompts you to select the language to use during installation.

English is the language selected by default, but you might want to choose another one. Do so, and press
Enter or Forward.

SCREEN 2

T he next screen you'll get to see is the location map.

Select your location, either from the map or using the pull down menu. Press Forward.

SCREEN 3

T his screen is for your keyboard layout.

Select the option that suits you best, and Press Forward.

SCREEN 4

T he next screen allows you to choose whether you want to install Freedom Fone on the entire hard
drive or side by side with another operating system that may be on your PC already. We  stro ngly
disco urage  that yo u install Freedo m Fo ne  s ide  by s ide  with ano ther o perating system f o r a live
deplo yment. For demonstration purposes you may do so but this is a complex process which requires
specific knowledge about computer partitioning. Only for advanced users!

For now, select the Erase and use the entire disk option.
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Remember that this  will erase  all that is  o n yo ur hard disk, including the  o perating
system. If  yo u have  no t saved yo ur data at this  s tage , se lect the  "Quit" butto n to  quit
the  installatio n pro cess  and restart f ro m the  beginning o f  the  pro cedure  af ter yo u
have  cleared up yo ur co mputer.

Otherwise, press Forward.

SCREEN 5

After selecting to use the entire disk, you are taken to the next screen which prompts you to set up your
user name and password, and name your computer:

1. T ype in your name and the username you want to use each time you log onto Freedom Fone.
2. T ake time to select a solid password as your system may carry information that could be a security

concern if accessed by unauthorised users.

Here are a few tips for a safe password:

keep it unique (only for your Freedom Fone access)
make it long and complex enough so that it is difficult to guess
You might alternate numbers and letters or special characters for your password,
while finding a trick to remember it - example: WAT ER4mydog.

3. Set the name of your PC making sure that the name you choose does not include any spaces.
4. For log-in options, we recommend that you choose the option require a password to log in for

security reasons.

Press Forward.

SCREEN 6

T his will only be seen in the case of side-by-side installations.

SCREEN 7

T he last screen will complete the installation.

Make sure you are happy with all the choices you made on the previous screens (language, login
name...). If you are not, press Back and repeat the steps 1 to 6 above. Otherwise, press Install.

T he actual installation process begins. T he installation may take a while depending on the hardware
specifications of your machine.  

Once installation is completed, the system will automatically eject your DVD and you will be prompted to
restart your system.

LOGGING IN

After restarting, here is what you will see:
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Occasionally Ubuntu might fail to restart the first time after installation. If this is the case, just manually
reset your machine, and it should reboot successfully. At the log in prompt, enter the user name and
password you have set in the installation process.

After logging into Ubuntu, click on the Freedom Fone icon on the desktop to launch the Freedom Fone
administration page. Freedom Fone version 2.S comes with a login screen to restrict access to
unauthorised users.

T he default username and password are as follows and can be changed later through the User
management interface

User name: Admin 
Password: thefone 
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Once you have successfully logged in you can move on to the next chapter Preparing SIM cards before
you set up your GSM device(s).
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PREPARING SIM CARDS
SIM cards provide Freedom Fone with access to the mobile network, allowing callers to reach your
platform in the same way that they are used to reaching each other.

T his chapter will explain how to choose your carrier(s) (Mobile Network Operator), how to prepare your
SIMs for use within the GSM device, and how to install the SIMs.

CHOOSING A CARRIER & PROCUREMENT

Choosing a carrier is a very important step in providing callers with access to your Freedom Fone service.
T here are a number of obvious items you may consider as well as some that are not immediately
apparent.

CONFIRM THAT DTMF WORKS ON YOUR CARRIER

The  mo st impo rtant f irst s tep is  to  co nf irm that Freedo m Fo ne  wo rks  with yo ur
carrier.

DT MF is a high pitched sound that a phone makes when a key is pressed.  T he Voice menu function of
Freedom Fone depends on these DT MF tones for a caller to make a selection inside a Voice menu e.g. To
hear market prices, press two.

Unfortunately some mobile phone operators do not support the use of DT MF and the Freedom Fone
hardware cannot hear when a user presses a button to make a selection. T o quickly check if a carrier
support DT MF, try making a call between two phones on this network and in the middle of the call try
pressing some buttons 1 2 3 etc. If you can hear the beeps and tones of the keypresses, the network
supports DT MF. If you dont hear any tones - there are several things you can do.

We have had cases where it is simply a matter of trying a different SIM card from the same mobile
carrier - try a few different SIMs. If that still does not work, you can test further by calling the default
Cholera menu after you have installed the Freedom Fone software.

If you are still unable to get the Freedom Fone service to respond to keypresses you could try speaking to
the technical support people at the carrier - otherwise you may need to consider using a different
carrier.  Note: All is not lost - you may still use functions that do not require caller key press selections
such as the Leave-a-message function or create a single informational Voice menu that a caller can listen
to.

COST FROM YOUR PERSPECTIVE

Which carriers are the cheapest to receive calls? In some countries, inbound calls are billable.

Which carriers offer the best SMS rates? T his may include bundles that can be bolted on to your service
plan to offer discounted volume rates.

COST FROM THE CALLER'S PERSPECTIVE

Which carriers are your callers on? Cross network calls are often more expensive than same network
communication.

Discounted call times or promotions? Are there any discounts or promotions that you can take advantage
of from a mobile carrier?
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Sometimes, offering a choice for callers to access your service through multiple carriers will increase the
likelihood that they will call. Remember to advertise all your numbers and carriers to help callers make
the appropriate choice.

NETWORK RECEPTION AT FREEDOM FONE SERVICE LOCATION

Check to see which carriers offer the best reception at the physical location of your Freedom Fone
service. T he better the signal, the higher the quality of call.

NETWORK RECEPTION AT CALLER'S LOCATION

If targeting a specific audience based on geography, ensure that the carrier of choice also has reception
in that location.

SELECTING MSISDN (MOBILE NUMBER)

If purchasing multiple SIM cards, try to get telephone numbers that are consecutive or highly
memorable.Many mobile phone operators will let you choose these numbers.

SECURITY

Never forget that carriers maintain call data records. In some sensitive environments, security issues and
the trust you have in the carrier might guide your choice.

SIM CARD PREPARATION

Before installing a SIM card into the GSM device you plan to use, ensure that you follow these simple
steps:

1. Insert SIM into a mobile phone
2. Verify the following:

All PIN requests  o n the  SIM have  been remo ved: this  is  usually f o und in a "Security"
o ptio n within "Settings" o n mo st handsets

T here is good carrier coverage
T he SIM is active and has been registered: test by calling the SIM, and sending and receiving an
SMS
It is topped up with airtime and it meets the pay-as-you-go operational requirements specific to
your country
Delete all SMSs that exist on the SIM. T his will ensure that the SIM is not full and therefore unable
to receive new messages. T his is usually an option within the SMS/Messaging application on most
handsets.

SIM CARD INSTALLATION

It's now time to place the SIM(s) into the GSM device that you have chosen to use. Please follow the
instructions of that specific device; to understand how to do this, see chapters the Connecting OfficeRoute
or Connecting MobiGater depending on your hardware.
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CONNECTING A 2N OFFICEROUTE

SETUP VIA WEB BROWSER

T he 2N® OfficeRoute is a GSM gateway that can be connected to Freedom Fone to enable you to receive
calls and SMSs. After installing Freedom Fone on your computer you can proceed to configure the
OfficeRoute. We recommend using a crossover cable and configuring the OfficeRoute using the Firefox
browser installed on your Freedom Fone server.

T he OfficeRoute can also be configured using a computer running Windows, a USB cable and the
Windows utility provided on the CD with your equipment. 

BEFORE YOU BEGIN:

Make sure you have a crossover cable
Use your mobile phone to disable the PIN code request for all the SIM cards you intend to use,
before inserting them in the OfficeRoute
Locate the office_route folder on the desktop of the computer where you installed Freedom Fone.
Inside the folder you will find an archive with a filename similar to backup_officeroute_2.3.11.tgz. T he
name will change depending on the OfficeRoute firmware version to be uploaded. 
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SETTING UP

Be  caref ul to  no t le t the  SIM card f all into  the  Of f iceRo ute  - this  can happen when yo u
insert the  card between the  chass is  and the  gap (these  can be  remo ved by caref ully
balancing the  Of f iceRo ute  o r o pening with a screwdriver).

While the OfficeRoute is switched off, insert your SIM cards into the bays at the front of the device. 
SIM cards should be inserted into the top slots (SIM2 and SIM1) with corner into the chassis and
chip-side down. Sim cards should be inserted into the bottom slots (SIM4 and SIM3) with corner
into the chassis and chip-side up. Push until the SIM cards click into place. Pushing them gently is
also how you remove the SIM cards. Do not remove or insert SIM cards when the OfficeRoute is
switched on.
Connect the crossover cable to the ethernet point on the OfficeRoute and connect the other end of
the crossover cable to the computer running Freedom Fone.
Attach the aerial
Attach power cable, plug your OfficeRoute in and turn it on; note that when you first power on the
OfficeRoute, it takes a few minutes to boot as it cycles through checking the SIM cards
Using the Firefox browser on the Freedom Fone server enter the default IP address of the
OfficeRoute, 192.168.1.1 ; if it does not work, try 192.168.1.46.

1. CONFIGURATION WIZARD

If you are connecting to the 2N® OfficeRoute gateway for the first time or after a factory reset, the
configuration wizard should appear.

FINISH

T hat’s all we need to do for now, so select Finish from the menu on the left hand side and exit the
configuration wizard. In order for Freedom Fone to accept calls from the OfficeRoute and direct them to
the Voice menus you have created, you will need to modify the default configuration settings on the
OfficeRoute.
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2. MODIFYING SETTINGS VIA WEB BROWSER

2A. LOGIN

Now that the initial wizard configuration is completed, you can configure all the OfficeRoute parameters
using the web browser interface. T o establish connection with the OfficeRoute, enter the default IP
address 192.168.1.1 of the OfficeRoute into the browser bar (if it does not work, try 192.168.1.46). After
entering the IP address you should see a screen prompting you for a “Username” and “Password”.
Username and Password are case sensitive.

Username: Admin 
Passwo rd: 2n

Press the login icon.

2B. CLEARING THE BROWSER’S CACHE

Sometimes your browser will not allow you to enter the Username and Password, instead it will keep
redisplaying the Username it has cached in memory.

For Firefox users: 
From the Firefox main menu select Edit > Preferences
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Under Security ensure that the option to remember passwords for sites is off.

Under Privacy clear all history, including the cache. 
Refresh the login page and the Username should now be blank.

2C. LICENSE

After a successful login, the network information page of OfficeRoute configuration application is
displayed. You can return to this page at any time by selecting the Network tab at the top of the page.

On this page (see screenshot below) take note of the lines with the following settings:

“SIP” - adjacent to this the value should be Enabled 
“Expires  (ho urs)” - adjacent to this the value should be Unlimited or Never 
“SNMP”  - adjacent to this the value should be Enabled

If for any reason the three parameters have different values assigned to them please contact the dealer
who supplied you with the equipment and request an unlimited licence with SNMP and POP enabled.

UPLOADING A LICENCE TO YOUR OFFICEROUTE

If you have to request a licence from your supplier, it will be supplied in the form of a .key file. T o upload
the licence to your OfficeRoute, select the Administration tab at the top of the page. Select Upload licence
from the menu on the left hand side. Use the browse button to locate and upload the key file provided by
your supplier.

Also on the network information page, check to see that the firmware version running on your
OfficeRoute is the latest available from 2N.

At the time of writing this guide the current firmware version is 2.3.13. You can view the firmware version
under the System information section - check for the line which displays Version. If the version of firmware
you are running is old you should download the latest from the 2n website:
http://www.2n.cz/en/products/umts/officeroute/downloads/
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2D. UPGRADING FIRMWARE

You can skip this section if you are running the current firmware version. Once you are done
downloading the firmware, select the Administration tab at the top of the page. T he page shown below
should be displayed.

Select Update firmware from the menu on the left hand side and using the browse function navigate to
your newly downloaded file, select it and click save from the options in the bottom right hand corner of
the screen.

T he loading process will start and should take about 5 minutes...be patient! T hereafter the OfficeRoute
will reboot and you will be required to log in again. Once you are logged in, check to see that the version
number has changed on the screen displayed. If not, repeat the upgrading firmware instructions.
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2E. SYNCHRONIZING TIME

In order for your call data records to be accurate you will need to synchronize the time of the
OfficeRoute to that of the Freedom Fone server.

Select the Administration tab at the top of the page. T hen select Synchronize time from the menu on the
LHS of screen. A screen showing the time on the OfficeRoute and the time on the Freedom Fone server
will be displayed. Click on the synchronize button to set the OfficeRoute time to the time of the Freedom
Fone server.

2F. UPLOADING THE BACKUP FILE

Select the Administration tab at the top of the page. T hen select Configuration backup from the menu on
the LHS of screen. A submenu will be displayed beneath Configuration backup. Select Upload config.
Browse for the backup file you found on the Freedom Fone desktop (look for a filename similar to
backup_officeroute_2.3.11.tgz) and upload the file by clicking on the Upload icon. T he process will take
about 5 minutes after which the system will reboot.

After rebooting, the OfficeRoute will have the new default settings required for operation with Freedom
Fone. T he default IP address that Freedom Fone assigns to the OfficeRoute is 192.168.1.46. Hence, after
uploading the backup file the IP address of the OfficeRoute will no longer be 192.168.1.1. T o login again,
you will need to enter 192.168.1.46 in your browser bar to access the OfficeRoute.

2G. NORMALISATION

T he OfficeRoute can apply rules to the prefix of the incoming caller ID string (phone number) – allowing
you to modify the OfficeRoute to work with phone number formats used in your country. T he reason for
this is to maintain consistency in the format of your call data records. Operators insert different prefixes
at the start of the caller IDs (phone numbers) e.g. + or 00.

In order for your call records to be uniform regardless of the operator from which the call originates, it
may be necessary to change the normalization settings. T o do this select the Telephony Services tab at the
top of the page. Next select GSM routing from the menu displayed on the LHS and Normalisation from the
submenu that is subsequently displayed beneath GSM routing.

T he screenshot below shows an example of normalization settings. In this example, any incoming caller
ID number which begins with the pattern +420 will have +420 removed and a zero inserted at the
beginning of the number.
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T he Remove count specifies from which point of the prefix the OfficeRoute should start removing digits. A
remove count of zero means characters will be stripped from the start of the prefix value. In the example
above, all digits in the specified prefix, starting from +, will be removed and a zero (0) be prefixed to the
remaining number. In this case, the country code (+420) is removed and a zero (0) inserted to make up
the local area code.

2H. ROUTING CALLS TO VOICE MENUS

If you have followed all the steps above, you should be able to make a phone call to a SIM card
previously inserted into the OfficeRoute, and have it answered by Freedom Fone’s default IVR menu. Note
that the default IVR menu is assigned a service number of 4100.

By def ault the  SIM card in s lo t #4 (GSM mo dule  - 4 in screensho t be lo w) is  co nf igured
to  direct all inco ming calls  o n this  number directly to  the  Leave-a-message  with service
2100. If  yo u wish to  change  this  setting so  that SIM #4 po ints  to  yo ur Vo ice  menu
[ 4100] , yo u can change  this  by f o llo wing the  instructio ns  be lo w

After you’ve created your own Freedom Fone voice menus, you will want to redirect incoming calls via
the OfficeRoute to service numbers associated with these menus (Freedom Fone voice menu service
numbers are displayed on the IVR centre > Voice menu page). T o do this select the Telephony services tab
at the top of the page. Next select GSM routing from the menu displayed on the LHS and GSM from the
submenu that is subsequently displayed beneath GSM routing. You should see a page similar to the one in
the screenshot displayed below.

Use the pencil to the right of each row to change the service name of the IVR menu to that associated
with your new Freedom Fone voice menu(s). When done, click the save button in the bottom right hand
corner of the screen. As you will probably have figured out, it is possible to have each GSM module (SIM
card) pointing to the same or a different IVR menu by changing the service name associated with the
module. T he Description field is for documentation purposes.
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Having followed the steps to this point, you are ready to use your OfficeRoute with Freedom Fone.

3. ADVANCED SETUP

T he following is advanced set up and not necessary for basic use.

3A. CHANGING ADMIN USER PASSWORD

T here are two ways of changing the default password of the OfficeRoute:

If you are connecting to the OfficeRoute for the first time, or connecting after a factory reset, you can use
the OfficeRoute wizard.

T he second way is to log into the OfficeRoute using the default username (Admin) and password (2n),
then select the User Management tab at the top of the page to change these details.

T he two methods are outlined below.

Important: Since Freedom Fone uses the password to authenticate with the OfficeRoute, you must modify
a Freedom Fone configuration file to use the new password. Communication between Freedom Fone and
the OfficeRoute will fail until you do so. Instructions are provided in the sub section entitled Modify
Freedom Fone configuration file.

i. Us ing the  Wizard

From the wizard’s LHS menu, select option 2, Administrator's password. You will be prompted to enter the
new password twice and when done click on the save button at the bottom of the page.
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ii. Changing Passwo rd us ing User Management tab

Select the User Management tab at the top of the page. Next select Users from the menu on the LHS. Use
the edit function (pencil) on the row with user Admin. Enter the new password twice in the fields provided
on the form and save.

3A1. Mo dif y Freedo m Fo ne  co nf iguratio n f ile

Use the command line terminal icon in Freedom Fone to go into terminal mode. (Click on the terminal
icon in the centre of the title bar at the top of your screen). At the command line prompt type the
following command:

For version 2.0 users 

gedit /usr/local/freedomfone/office_route/config.php

For version 2.S users

gedit /opt/freedomfone/office_route/config.php

T he config.php file should open in the gedit editor. Look for the code snippet shown below and change
the 'pass' setting to the new password you have set for the OfficeRoute. Save and close the file.

If you are connecting more than one OfficeRoute you should change the other instances of 'pass'
following the code snippet shown below.
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$_OfficerouteParamSingle = array(

array(

'host'=>'192.168.1.46',

'user'=>'Admin',

'pass' =>'2n',

'port' =>'110'

)

);

3B. CHANGING THE DEFAULT IP ADDRESS OF THE OFFICEROUTE

T he default IP address assigned to a new OfficeRoute by the supplier is 192.168.1.1. If the Freedom Fone
OfficeRoute backup config file has been uploaded to the OfficeRoute, the IP address of the device will be
set to 192.168.1.46.

You can modify the OfficeRoute's IP address by selecting the Network tab at the top of the page. Next
select Main configuration from the menu displayed on the LHS. Select the modify icon in the bottom right
hand corner of the screen to edit details on this screen.

Important: Since Freedom Fone uses the OfficeRoute IP address to authenticate with the OfficeRoute, you
must modify 2 Freedom Fone configuration files to reference the new IP address. Communication
between Freedom Fone and the OfficeRoute will fail until you do so. Instructions are provided in the sub
section entitled Modify Freedom Fone configuration files.

Remember to save your changes.

3B1. Mo dif y Freedo m Fo ne  co nf iguratio n f iles

Use the command line terminal icon in Freedom Fone to go into terminal mode.

i. At the command line prompt type the following command:

For version 2.0 users

gedit /usr/local/freedomfone/office_route/config.php
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gedit /opt/freedomfone/office_route/config.php

T he config.php file should open in the gedit editor. Look for the code snippet shown below and change
the 'host' setting to the new IP address you have allocated to the OfficeRoute.

Save and close the file.

If you are connecting more than one OfficeRoute you should change the other instances of 'host'
following the code snippet shown below.

$_OfficerouteParamSingle = array(

array(

'host'=>'192.168.1.46',

'user'=>'Admin',

'pass'=>'2n',

'port'=>'110'

)

);

ii. At the command line prompt type the following command:

For version 2.0 users

gedit /usr/local/freedomfone/config/officeroute_snmp_config.php

For version 2.S users

gedit /opt/freedomfone/config/officeroute_snmp_config.php

Look for the code snippet shown below and change the 'ip address' setting to the new IP address you
have allocated to the OfficeRoute.

$config['OR_SNMP']= array(

array('ip_addr' => '192.168.1.46' ,

'community' => 'public' ,

'object_id' => '1.3.6.1.4.1.6530.4.2.2.1'

)

);

Save and close the file.

3C. CHANGING THE VIRTUAL IP ADDRESS OF THE FREEDOM FONE SERVER

By default the Freedom Fone server is allocated a secondary fixed IP address of 192.168.1.250 which is
assigned as a virtual IP address to eth0:0

T o view the server’s network settings, use the command line terminal icon in Freedom Fone to go into
terminal mode. T ype the following command:

ifconfig

Details will be displayed as shown in the screenshot below.
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If you need to change the secondary fixed IP address allocated by default to the Freedom Fone server you
must follow the steps below.

Note though, that you can modify the OfficeRoute SIP server setting to refer directly to the primary IP
address of the Freedom Fone server instead of the secondary fixed IP address. If you are having problems
with your setup, try taking this step (3d) before modifying the secondary fixed IP address.

Use the command line terminal icon in Freedom Fone to go into terminal mode.

i. At the command line prompt type the following command:

gedit /etc/rc.local

Look for the code snippet shown below and change 192.168.1.250 as required for the interface aliasing for
the OfficeRoute.

/sbin/ifconfig eth0:0 192.168.1.250 netmask 255.255.255.0 up

Save and close the file.

ii. At the command line prompt type the following command:

For version 2.0 users 

gedit /usr/local/freeswitch/conf/sip_profiles/officeroute.xml

For version 2.S users 

gedit /opt/freeswitch/conf/sip_profiles/officeroute.xml

Look for the code snippet shown below and change 192.168.1.250 as required
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Save and close the file.

Don’t forget to update the corresponding setting on the OfficeRoute by following the next step, "Change
the SIP server setting on the OfficeRoute."

3D. CHANGING THE SIP SERVER SETTING ON THE OFFICEROUTE

If you do not want to use the default IP settings for the Freedom Fone server (a secondary fixed IP
address of 192.168.1.250 which is assigned as a virtual IP address to eth0:0), you can modify the default SIP
server setting used by the OfficeRoute to communicate with the Freedom Fone server.

Select the Telephony Services tab at the top of the page. Next select Devices from the menu on the LHS and
SIP lines from the submenu that is subsequently displayed beneath Devices.

Use the edit icon (pencil) to change the IP address of the SIP server from 192.168.1.250 to the primary IP
address of your Freedom Fone server.

Save your changes.

3E. MODIFYING YOUR CONFIGURATION TO COMMUNICATE WITH MULTIPLE OFFICEROUTES

i.  At the command line prompt type the following command:

For version 2.0 users

gedit /usr/local/freedomfone/office_route/config.php

For version 2.S users

gedit /opt/freedomfone/office_route/config.php

Look for the code snippet shown below and add the 'ip address' settings for all the OfficeRoutes to the
OfficerouteParamMulti array. In the example below there are 3 OfficeRoutes connected and their IP
addresses are 192.168.1.46, 192.168.1.45 and 192.168.1.44 
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$_OfficerouteParamSingle = array(

array(

'host'=>'192.168.1.46',

'user'=>'Admin',

'pass'=>'2n',

'port'=>'110'

));

$_OfficerouteParamMulti = array(

array(

'host'=>'192.168.1.46',

'user'=>'Admin',

'pass'=>'2n',

'port'=>'110'

),

array(

'host'=>'192.168.1.45',

'user'=>'Admin',

'pass'=>'2n',

'port'=>'110'

),

array(

'host'=>'192.168.1.44',

'user'=>'Admin',

'pass'=>'2n',

'port'=>'110'

));

Save and close the file.

ii. T o ensure SMSs are read from all OfficeRoutes, at the command line prompt type the following
command:

For version 2.0 users 

gedit /usr/local/freedomfone/office_route/pop3_daemon.php

For version 2.S users 

gedit /opt/freedomfone/office_route/pop3_daemon.php

Look for the code snippet shown below and change $_OfficerouteParamSingle; to $_OfficerouteParamMulti;

$handle = fopen(LogFile,'a');

$_OfficerouteParam = $_OfficerouteParamSingle;   //Change to $_OfficerouteParamMulti if

multiple users are used

$sock = new ESLconnection($host, $port, $pass);

Save and close the file.
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CONNECTING HUAWEI GSM DONGLES
Freedom Fone v2.S.4 now supports the Huawei E173 and E1550 GSM dongles. T he downside is that
Freedom Fone version 2.S.4 no longer supports the Mobigater out of the box. 

Please  co nnect o ne  do ngle  at a time. Fo llo w steps  1-3 be lo w f o r each Huawei do ngle  added. If
yo u need to  remo ve  a do ngle  f o r any reaso n, switch the  Freedo m Fo ne  co mputer o f f  be f o re
yo u do  so . 

1. IDENTIFY THE DETAILS ASSOCIATED WITH THE HUAWEI DEVICE

After you connect the Huawei dongle to the Freedom Fone computer, open the command terminal
(Ctrl+Alt+T ) and issue the following commands. Press the Enter key at the end of each line.

When prompted for a password:

FFv2.S.4 users type manguensis

FFv2.S.7 and 2.S.8 users type sharicus 

$ sudo su

# ls -l /dev/ttyUSB*

NB: the command above is case sensitive and all spacing must be observed, so please copy exactly! 

After issuing the command shown above you should get a display that looks similar to that shown below:

Each Huawei USB device will have 3 entries associated with it. In the above example the device we
connected is associated with the following entries /dev/ttyUSB0, /dev/ttyUSB1, /dev/ttyUSB2. 

We only need to use 2 of the 3 entries displayed to configure the Huawei device. One of the entries will
be used for the line associated with the co ntro ldevice_name  parameter and the other for the
co ntro ldevice_audio _name  parameter. 

T he entry with the highest numbered ttyUSB will be associated with the co ntro ldevice_name  parameter
and the entry with the second highest numbered ttyUSB will be associated with the
co ntro ldevice_audio _name  parameter.

2. EDITING THE CONFIGURATION FILES

T o edit the Huawei configuration files issue the following command: 

# gedit /opt/freeswitch/conf/autoload_configs/gsmopen.conf.xml
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After entering the command above a new page should open on the screen and its contents will look as
follows: 

For the f irs t Huawei device  connected, update the configuration file for interf ace  1 to match the
settings displayed by the ls -l /dev/ttyUSB* command. In this example we will assign the
co ntro ldevice_name  parameter to /dev/ttyUSB2 because this is the highest numbered entry for the
inserted device. On the next line which references the co ntro ldevice_audio _name  parameter we
assign /dev/ttyUSB1 because the second highest numbered ttyUSB entry is /dev/ttyUSB1. 

NB: Please note that computers handle the naming of ttyUSB entries differently depending on the USB devices
that are already connected, so it is important that you match the configuration according to the settings
displayed after inserting the Huawei device. 

T he last line which references the destinatio n parameter should be edited to point to the service
number associated with the voice menu to which you wish to connect callers who phone the SIM in this
dongle. T he default settings point to 4100 for the first 2 Huawei devices connected and service 2100 for
the third device connected. If you have only one device connected just edit the section under "Interface 1". 

It is possible to add more than 3 Huawei dongles to the system, but should you wish to do so, we advise
that you use a ttyusb hub to connect the dongles. If you decide to add more than 3 Huawei dongles then
make sure that you update the configuration file to reflect the number of devices you have added. Each
additional device should have a section in the /opt/freeswitch/conf/autoload_configs/gsmopen.conf.xml
configuration file similar to the following (remember to change the interf ace  id and name  parameters): 
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   <interface id="3" name="interface3">

      <param name="controldevice_name" value="/dev/ttyUSB8"/>

      <param name="controldevice_audio_name" value="/dev/ttyUSB7"/>

      <param name="destination" value="2100"/>

    </interface>

Copy the section shown above and paste immediately after the third section in the default file, but take
care to increment  the interf ace  id parameter by 1 and also change the name parameter. 

In our example if we wanted to add a fourth device we would copy and paste a section immediately after
the third section.  T he new section should look like: 

  <interface id="4" name="interface4">

      <param name="controldevice_name" value="/dev/ttyUSB9"/>

      <param name="controldevice_audio_name" value="/dev/ttyUSB8"/>

      <param name="destination" value="2100"/>

  </interface>

Also make sure that the co ntro ldevice_name parameter and co ntro ldevice_audio _name  parameter
are updated according to your specific ttyUSB entries. After you have done all this, save and close the
/opt/freeswitch/conf/autoload_configs/gsmopen.conf.xml configuration file using the icons or menus at
the top of your window.

3. RESTART FREESWITCH

For the configuration modifications you have made to take effect, you have to restart FreeSWIT CH. T o
do that, open a command terminal (Ctrl+Alt+T ) and issue the following commands. Press the Enter key at
the end of each line. 

$ sudo su

# service freeswitch restart

Wait for the command prompt to be redisplayed (you should see [OK] displayed on the ride hand side of
the screen). 

T hen issue the following command, followed by the Enter key: 

# /etc/init.d/dispatcher_in restart

T he above commands should restart FreeSWIT CH and the Dispatcher. T he next time you call you will be
directed to the service you have updated in the configuration file. 
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CONNECTING A MOBIGATER

1. Ensure that the MobiGater is not connected to a power supply and is also not connected via USB to
the computer. T he computer that Freedom Fone has been installed on must also be switched off.

2. Insert the SIM card into the bay inside the MobiGater. 

3. Make a note of the MobiGater IMEI and the telephone number of the SIM that has been inserted
into it.

4. Connect the MobiGater to the power supply
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5. Attach the MobiGater to the computer via the USB cable. 

6. If all is correct, the LEDs on the MobiGater will light up as follows: the LEDs under the power and
USB icons will both light up red. T he LED under the mobile phone icon will flicker red roughly every
four seconds, as the SIM card polls the nearest mobile network tower. 

7. T urn on the computer
8. If the Freedom Fone user interface is not already open, double click the Freedom Fone shortcut on

the Desktop. Select Dashboard > GSM channels from the main Freedom Fone menu. T he MobiGater
you’ve just connected should be displayed. You may need to click the Refresh button a number of
times to see this.

We have  a kno wn pro blem with so me co mputer mo therbo ards  with regards  to
co nnecting multiple  Mo biGaters . Co nnecting multiple  Mo biGaters  o n so me
mo therbo ards  may result in co ncurrent vo ice  calls  interf ering with each o ther.

See the T roubleshooting section if you are having difficulty connecting MobiGaters.

MODIFYING DEFAULT SETTINGS

By default the MobiGater is configured to connect calls to the Voice menu with service number 4100. T o
direct your calls to another Voice menu, or to a Leave-a-Message IVR (LAM IVR) you will need to edit the
/usr/local/freedomfone/xml_curl/dialplan.xml file.

For 2.0 users

gedit /usr/local/freedomfone/xml_curl/dialplan.xml
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For 2.S users

gedit /opt/freedomfone/xml_curl/dialplan.xml

Look for this code snippet:

      <extension name="inbound_Mobigater1">

          <condition field="destination_number" expression="^5000$">

            <action application="transfer" data="4100 XML default"/>

          </condition>

      </extension>

      <extension name="inbound_Mobigater2">

          <condition field="destination_number" expression="^5001$">

            <action application="transfer" data="4100 XML default"/>

          </condition>

      </extension>

      <extension name="inbound_Mobigater3">

          <condition field="destination_number" expression="^5002$">

            <action application="transfer" data="2100 XML default"/>

          </condition>

      </extension>

You can see that the default values are 5000->4100, 5001->4100, 5002->2100. In version 2.0, this file will be
created via the GUI once we implement ACL with the system.
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TESTING YOUR SET UP
After installation has been completed, and all the GSM devices have been connected, why not test
Freedom Fone with the audio samples supplied? Freedom Fone comes bundled with a entire sample
Voice Menu which allows you to test the functionality and configuration of your Freedom Fone
installation.

VOICE MENUS

A sample menu called Cholera will be available immediately after installation. T his menu has been
designed to test the selection of items within the menu, and to demonstrate Freedom Fones' ability.

T o test, simply place a call to the SIM card that has been installed in your GSM device during installation
from a telephone, and listen out for the Cholera menu welcome tune. 

Listen carefully to the prompts and select one of the Menu options offered. Once the Menu option
completes, you will hear the Voice menu’s Instructions prompt repeat.

If you CANNOT  get Freedom Fone to respond to the selections you are making using your phone’s key
pad, see the T roubleshooting Guide in the Documentation folder on the Freedom Fone Desktop.

T o monitor your call, select System Data > Call data records from the main Freedom Fone menu. You can
click on the Refresh button at any time to view information associated with completed calls or calls in
progress.

You can see details of key selections made by a caller in response to a Voice menu by selecting Voice
menus > Monitoring from the main Freedom Fone menu.

LEAVE A MESSAGE

In the sample menu Cholera, you are able to test the Leave a Message functionality.

T o test, place a call to the SIM card that has been installed in your GSM device during installation from a
telephone, and listen out for the Cholera menu welcome tune.

Listen out for, and follow the menu option to Leave a Message (option #5). Follow the audio prompts,
leave your audio recording, then hang up. 

You will hear the default Freedom Fone Leave-a-Message IVR Menu and experience the basic Leave-a-
Message functionality.

After you hear a beep, you should leave your voice message and then hang up. T his action will
automatically cause your voice message to be saved.

When you then access the Message Center Inbox, you should see your newly created audio file. T ry
playing it, and see how the quality is.

If you hear this, Success! Your GSM devices and Freedom Fone are now configured correctly for Leave a
Message.
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SMS

T o test the SMS receiving functionality, sending a simple SMS to the number in your GSM device from
another telephone will suffice. After you have sent this, visit the Message Centre - Incoming SMS to see if
your SMS has arrived.

If you see this, Success! Your GSM devices and Freedom Fone are now configured correctly for SMS.

TROUBLESHOOTING

If you do not get an expected result, check out our troubleshooting guide in this book for hints on how to
fix common issues surrounding configuration and installation.

129



LOCALISE USER INTERFACE
Freedom Fone facilitates PO based localisation. For more technical information on how to extract all
strings into a PO file, read the Localisation section of our Developers' Guide.

Freedom Fone have already localised the user interface into various languages that you can take
advantage of. If you would like to change your version of Freedom Fone into a language more suitable
for you, follow these steps. 

T he example provided is for adding a French localisation.

Download a copy of the latest French language file from the Freedom Fone website.

Copy your localised po file to the Desktop on your Freedom Fone server. If it has a different file name,
rename your localised po file to default.po

Open a terminal windo w (by clicking on the T erminal icon in the centre of the T itle bar at the top of the
Freedom Fone desktop screen) and create a new folder with the three letter ISO code (ISO_6393) for the
new language. Make sure to use international conventions to name your folder. For more information
visit http://www.sil.org/iso639-3/codes.asp

For 2.0 users

cd /usr/local/freedomfone/gui/app/locale

sudo mkdir fre

cd fre

For 2.S users

cd /opt/freedomfone/gui/app/locale

sudo mkdir fre

cd fre

Create a folder called LC_MESSAGES under your new language folder

sudo mkdir LC_MESSAGES

cd LC_MESSAGES

Copy your localised default.po file to the LC_MESSAGES folder

 cp /home/manguensis/Desktop/default.po default.po

Important: Please note that the folder name 'manguensis' may change if you are using a different version:
v2.0.x = sekowei 
v2.S.7, 2.S.8 = sharicus 
v2.D.x = suyo

Change permissions to make default.po executable by all users

chmod a-x default.po

Next, we need to add the new language as an option to the dropdown language selector on the
Freedom Fone Dashboard > Settings page.

Open the CakePHP configuration file

For 2.0 users
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gedit /usr/local/freedomfone/gui/app/config/config.php

For 2.S users 

gedit /opt/freedomfone/gui/app/config/config.php

and add your language to the bottom of the $config['LANGUAGES'] variable. Make sure to add a comma to
the end of the line above your entry.

config['LANGUAGES']=   array(

'eng'   =>   __('English',true),

'fre'   =>   __('French',true),

'por'   =>   __('Portuguese',true),

'esp'   =>   __('Spanish',true),

'swa'   =>   __('Swahili',true)

);

In the background, CakePHP applies the selected locale in the AppController (before Filter).

T o test your localisation, go to the Freedom Fone Dashboard > Settings page and select your new
language option.
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T ro u b l esh o o tin g
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INSTALLATION

INSTALLATION DOES NOT START

If you notice when installing that your computer loads straight back into your previous operating system,
there may be an issue with your BIOS boot order settings. 

T he instructions on how to get into the BIOS settings varies for different computer models. Please
consult your computer's manual for more instructions.

You may also fail to see the first screen in the Installation sequence if your Freedom Fone install DVD has
defaulted to LiveCD mode. T his happens by default if you wait too long before selecting the Install
Custom Live CD option.
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GSM DEVICE

PHONE NUMBER NOT AVAILABLE

Go to the Dashboard > GSM channels screen in the Freedom Fone user interface to check the signal level
associated with the SIM card you are calling.

On the tables that appear, look for the Signal level column.

FOR THE OFFICEROUTE

Signal level values for the OfficeRoute can be poor, good or excellent. If the signal is poor please find a
better location for the OfficeRoute or extend your aerial to a place where you can get better reception.

Also check that the IMSI number is present for each SIM card in the OfficeRoute. If not, shut down both
the computer and the OfficeRoute, ensure that the SIM cards are properly seated and power up your
devices again.

FOR THE MOBIGATER

Signal level values for the MobiGater should read 2 or higher for satisfactory performance. If the signal
level value is lower than 2 please find a better location for the MobigGater device.

Also check to see if both the IMSI and IMEI values are populated on the MobiGater tables. If not please
shutdown your computer and power down the MobiGater device. Ensure that the SIM card is properly
seated and then reconnect the device and power up again.

CALLS CONTINUOUSLY RING

T here are many causes for this problem and we have outlined them in the logical order in which you
should troubleshoot.

a. An expired License or a not fully licensed OfficeRoute causes calls not to be transferred to the
Freedom Fone. T o check that you have a full License enter the IP address of the OfficeRoute in a
browser and log in. Under the network tab check to see that SNMP is enabled as well as that the
License has not expired. If you find that your license has expired or that you don't have all features
enabled please contact your supplier of the OfficeRoute.

b. eth0:0 which is the network alias has to be set on the computer running Freedom Fone in order for
Freedom Fone to communicate with the OfficeRoute. If you issue an ifconfig command (click on the
T erminal icon in the centre of the title bar at the top of the Freedom Fone desktop screen) and you
do not see a reference to eth0:0 with an IP address of 192.168.1.250 on the output, follow the
instructions on setting the network alias given in this document.

c. If FreeSWIT CH has stopped running Freedom Fone will not communicate with the OfficeRoute.
From Freedom Fone navigate to: Dashboard → Health, on the interface that appears, check to see if
both the Freeswitch and the dispatcher are running. If both are running a green tick will show
against each, if not a red circle will show.

If the FreeSWIT CH has stopped for some reason, open the command terminal and issue the following
command:

service freeswitch restart

T he following message should appear after running that command:
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Freedom Fone: Starting Freeswitch freeswitch

If the dispatcher has stopped, run the following command from the command terminal:

/etc/init.d/dispatcher_in reload

T his command should be followed by an output shown below:

Freedom Fone: Stopping dispatcher [OK]

Freedom Fone: Starting dispatcher [OK]

After issuing the above commands navigate to Dashboard > GSM channels, refresh the page and check if
the MobiGaters / OfficeRoute have registered to your local current time. NB: It may take several refreshes
before the GSM devices register.

When done, try calling the numbers inside your GSM devices.

If the SIP server IP address is not set to the IP address of the computer running Freedom Fone, calls to
the OfficeRoute will ring continuously. T o rectify this open the OfficeRoute interface by typing the IP
address of the OfficeRoute into the browser URL window.

An OfficeRoute interface should appear, login with the correct username and password. T he default
username: Admin and the password; 2n.

From the office route interface click on the “T elephony services” tab at the top of the page.

On the interface which appears , look to your left and navigate to Devices > SIP lines

Use the edit function to edit the IP address of the SIP server. T his address should be the same as for the
computer running Freedom Fone.

CALLS IMMEDIATELY CUT OFF AFTER ONE RING

T his can be caused by a call that is routed to an IVR menu that does not exist. It may be due to an IVR
being accidentally deleted during operations.

From Freedom Fone navigate to ; IVR Centre > Voice Menu. On the interface that appears ensure that there
is at least one IVR menu set. If none is set, create one using the create button.

FOR THE MOBIGATERS

If there is at least one IVR menu set on the interface and yet calls keep cutting off, please follow the
instructions below:

Open the command terminal and enter the following command:

For version 2.0 users

gedit /usr/local/freedomfone/xml_curl/dialplan.xml

For version 2.S users

gedit /opt/freedomfone/xml_curl/dialplan.xml

T his should launch the gedit editor with the contents of the dialplan.xml file displayed. Scroll down the file
to a section with a subtitle “Inbound MobiGaters”. T he section should look like the code snippet shown
below
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<!-- INBOUND MOBIGATERS -->

<extension name="inbound_Mobigater1">

<condition field="destination_number" expression="^5000$">

<action application="transfer" data="4100 XML default"/>

</condition>

</extension>

<extension name="inbound_Mobigater2">

<condition field="destination_number" expression="^5001$">

<action application="transfer" data="4100 XML default"/>

</condition>

</extension>

<extension name="inbound_Mobigater3">

<condition field="destination_number" expression="^5002$">

<action application="transfer" data="2100 XML default"/>

</condition>

</extension>

T he IVR service numbers that are highlighted above should correspond with the IVR service numbers that
exist on your Freedom Fone server. Make sure that the service numbers shown in your dialplan.xml file
exist on your Freedom Fone. If the dialplan is directing calls to a voice menu that does not exist simply
edit the service number to a valid IVR service number. If you want to direct a specific MobiGater to a
Voice Menu other than the default 4100/ 2100 you can simply change the service number to the desired
service number of the voice menu you have created.

FOR THE OFFICEROUTE

If you check the Voice Menus page of the Freedom Fone and see that there is at least one IVR Menu set
please follow the instructions below:

Open the OfficeRoute web interface by typing the IP address of the OfficeRoute into the browser URL
window. Login by entering the username and password. T he default settings are:

username : Admin 
Passwo rd : 2n

After successfully logging in, click on the “T elephony services” tab at the top of the page . On the page
that appears look to your right and click on the GSM routing link, under the link click on GSM.

On the interface which appears ensure that each GSM module is directed to an IVR service number that
exists on the Freedom Fone. You can use the edit function to the right of each row to specify the service
number of the IVR.

CALLS GOING THROUGH BUT AUDIO BEING PLAYED BY LAPTOP
SPEAKERS

Some laptops may experience a problem in routing the audio back to the caller after answering a call.
T he audio is then routed to the speakers of the laptop instead of back to the caller via the phone. T he
caller will experience silence on her phone although the phone will show that a call is in progress. T his is
an issue to do with the USB of the laptop and is usually experienced when running two MobiGaters on
adjacent USB ports. T o rectify this follow the instructions below:

1. Shutdown laptop and power off MobiGater
2. Remove one of the adjacent MobiGaters and plug it in another USB which does not have anything

connected adjacent to it.
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3. Reboot your Laptop and start MobiGater.

OFFICEROUTE DOES NOT DISPLAY ON GSM CHANNEL PAGE
ALTHOUGH INBOUND CALLS BEING ANSWERED

T his is usually the case when you change the default IP address of the OfficeRoute 192.168.1.46 to
something else. Freedom Fone uses the IP address of the OfficeRoute to capture setting information such
as IMSI number, Network registration,Operator and Signal level.

T o rectify this open and edit the config.php file using the following command:

For version 2.0 users

gedit /usr/local/freedomfone/gui/app/config/config.php

For version 2.S users

gedit /opt/freedomfone/gui/app/config/config.php

Change the IP address of the OfficeRoute in the config.php file to the new IP address that you have
assigned the OfficeRoute. T he section you edit should look like the code snippet shown below;

config['OR_SNMP']= array(

array('ip_addr' => '192.168.1.46' ,

'community' => 'public' ,

'object_id' => '1.3.6.1.4.1.6530.4.2.2.1'

));

When done save the file and refresh your GSM channels page on Freedom Fone, you should see the
registered OfficeRoute.

137



PROBLEMS WITH VOICE MENUS

I CAN’T HEAR THE VOICE MENU PROMPTS BECAUSE A VOICE
KEEPS NAGGING ME ABOUT CEPSTRAL.

Cepstral is the text to speech (T T S) software used in Freedom Fone.  Our software will work without a
licence but before it reads each line of text, Cepstral will play a reminder that you need to buy a licence.
We are using the Allison 8 Khz voice for Linux.

You will be hearing this voice because you have entered text in the large text box labeled Description in
your Voice menu. If this is not what you want, you can remove this text and it will stop this problem.

FIX 1:BUY AND REGISTER A LICENCE FOR ALLISON 8 KHZ FROM THE CEPSTRAL WEBSITE

A licence for the Allison 8 Khz voice for Linux can be bought from https://www.cepstral.com/. Once you
get the licence you can register the voice by running the swift executable from the command prompt as
follows:

Open a terminal window by clicking the terminal icon in the centre of the title bar at the top of your
screen.
If you are prompted to enter a password 
FFv2.S.4 users type manguensis 
FFv2.S.7 and 2.S.8 users type sharicus
At the prompt type

/opt/swift/bin/swift --reg-voice

Follow the instructions to enter the details associated with your licence. You will be asked for Name,
Organisation and Licence key

FIX 2: CREATE YOUR OWN AUDIO FILES AND AVOID TEXT TO SPEECH COMPLETELY

If you use your own audio files you do not need to use text to speech at all!

I HAVE TRIED TO UPLOAD MENU OPTIONS BUT NONE OF MY
FILES ARE REFLECTED ON THE MENU OPTIONS SCREEN.
WHAT’S GOING WRONG?

T he chances are that the file you tried to upload was larger than the maximum file size of 10MB allowed.
Downsize the audio file by shortening its duration and/or ensuring it has been created as a WAV or MP3
file that is mono with a sampling rate of 8Khz.

Characters other than a-z, 0-9 or - and _ can create problems in filenames when you upload the files. If
you see the File not found message when you try to play uploaded audio content, try re-uploading the
content with a filename that follows the about rules.
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NETWORKING

NETWORK CARD IS NOT RECOGNISED AFTER HIBERNATION

T his is a bug in Ubuntu. Your interface names such as eth0 are assigned to a physical interface,
specifically the MAC address of that interface. When you hibernate and then try to restart, the system tries
to assign a new MAC address to your NIC. So when your MAC address changes the system thinks it’s a
new network card and assigns the next free name, lets say eth1.

However your network configuration file is still referring to the old name eth0. So basically you end up
trying to apply configuration to a NIC that doesn’t exist, while there is a new NIC with no configuration.
Basically no more network…

So how do you fix it?

Make a backup of the 70-persistent-net.rules file:

sudo cp /etc/udev/rules.d/70-persistent-net.rules /etc/udev/rules.d/70-persistent-

backup

Now when you have done a backup remove the file

sudo rm /etc/udev/rules.d/70-persistent-net.rules

Reboot the machine

reboot

So basically that just deleted all of the old MAC address to name (eth0) mappings, so when the system
boots these should be correctly created again.

NETWORK CARD IS NOT RECOGNISED ON NEW INSTALLATION

Not all Network cards have drivers which are supported by Ubuntu. It may happen that after installing
your Freedom Fone on a computer, you find that the Ethernet card does not appear when you issue the
ifconfig command. T he solution to this can be to change the Ethernet card. When choosing a network
card to replace, try and get something that is not the latest, as usually Ubuntu takes time to update its
driver database.

If you don't have another network card, you can connect a USB GSM modem to the computer or laptop
and connect to the Internet and then follow the instructions below. If you don't have the USB modem,
you will have to do this on another computer with Internet connectivity and then transfer the files you
would have downloaded.

Instructio ns

T o download, compile and install the driver, first go to http://linuxwireless.org/download/compat-
wireless-2.6 and download the file named compat-wireless-2.6.tar.bz2 (you can't download it in the
terminal because of anti-hotlinking). Save it to your desktop. T hen run these commands in a command
terminal:
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sudo apt-get update

sudo apt-get install build-essential

cd ~/Desktop

tar -xjvf compat-wireless-2.6.tar.bz2

cd compat-wireless-2.6.39-1/drivers/net/atl1c

make

sudo make install

T hen reboot. Hopefully your Ethernet will work automatically after reboot; if not, run:

sudo modprobe atl1c

to insert the driver.

NB: Although the drivers are included in the compat-wireless stack they are actually drivers for an
ethernet card not the wireless card. In the example I chose the compat-wireless-2.6.39-1.tar.bz2 because it
is the latest stable release for the kernel I am using. Whenever you look for drivers in future, choose the
latest stable release for the kernel you are running on. T o check the kernel version issue the command
uname -r on the command terminal.

SETTING NETWORK ALIAS PERMANENTLY

Freedom Fone sets the network alias on eth0:0 at boot time via the /etc/rc.local script. T his setting is not
permanent and is set each time you boot up. If for some reason the networking is not enabled when you
boot up the alias cannot be set. T his presents a challenge since Freedom Fone uses this alias to
communicate with the OfficeRoute. In such a scenario, in order to get Freedom Fone working you will
have to enable networking and reboot the machine.

T o avert having to reboot the machine every time you forget to enable networking before rebooting,
make the following additions to the
/etc/network/interfaces file (click on the T erminal icon in the centre of the T itle bar on your Freedom
Fone desktop).

Instructio ns

sudo gedit /etc/network/interfaces

Append the following configuration:

auto eth0:0

iface eth0:0 inet static

name Ethernet alias LAN card

address 192.168.1.250

netmask 255.255.255.0

broadcast 192.168.1.255

network 192.168.1.0

Save the file and restart the network with the following command:

sudo /etc/init.d/networking restart

From now on, if the eth0:0 does not appear after boot because networking has been disabled, you will
simply enable networking by right clicking on the wireless network icon at the top task bar, and then
issue the command above for restarting the network.
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OTHER PROBLEMS

PROBLEMS WITH TIMES

If you find that the log files are reporting the times incorrect or that the start time of Polls is not adhering,
then there may be an issue with your system time.

Check to see if the time in the top right corner of your Freedom Fone installation computer is set
correctly. If it is not, you may click on it and set it.   

FREEDOM FONE INTERFACE FREEZES

T his is usually caused by pulling out the GSM devices whilst Freedom Fone is running. Please check that
the power to the GSM devices is stable and all connections to the computer are firm.

CALLS GOING THROUGH BUT AUDIO BEING PLAYED BY LAPTOP
SPEAKERS

See Troubleshooting - GSM devices
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A u d io  C o o k b o o k
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WORKING WITH AUDIO AND FREEDOM
FONE
Freedom Fone has been designed for use across telephone networks. T his introduces a number of issues
that users must be aware of when creating audio files for the platform.

T elephony infrastructure transmits audio in a low quality format. T his means that the audio content we
create should be simple, easy to understand and created to specific technical specifications.

Since content is accessed by calling the phone numbers connected to a Freedom Fone server, playback
duration will be directly related to the cost of calling. Clarity and brevity will be valued by most callers.

 

143



SCRIPT WRITING FOR AUDIO

GENERAL TIPS
Read out your text whilst writing, this helps you to check the flow of your words.
Do rehearsals: ask people to listen to your text and to give feedback. Be self-critical.
Help the listener to understand: use simple language, explain unknown words and abbreviations.
Find an understandable structure for the information you offer e.g. begin with an overview and
move into details chronologically.
If a term is introduced, for example the word "parliament", don't switch to another term in the
same text, e.g. "assembly".
Keep sentences as short as possible.
Repeat important terms in order to remind the listener what you are talking about.
Avoid synonyms, they often confuse the listener.
Avoid using foreign words, if there is no alternative, provide a translation or an explanation.
If your script requires numbers, concentrate on just two or three key figures, those that are
absolutely necessary. Round the numbers off if this is possible without changing the information
content of your message. It is better to describe "50%" as "half" or "200" as "double" or "twice...".
When you talk about sizes, amounts or quantities of objects, it helps listeners to visualise what you
are saying if you draw comparisons. It is best to draw your comparisons from your listeners’ frame
of reference, things they know and can relate to. For example, instead of describing the height of a
wall as “2 meters 40 centimetres”, it would be more effective to say the wall is “taller than a man”.
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PRESENTATION TIPS

WRITING FOR LISTENERS

When writing a script for the radio, you should always bear one thing in mind: you are writing for
listeners, not for readers. Readers can re-read a sentence, skip a paragraph, read at their own
appropriate speed, listeners can’t!

Audio texts have to be well presented, logically structured and easy to understand. If listeners stumble
over unfamiliar words, lose their attention or are distracted for a moment, much of the message will be
lost.

Audio scripts are not literature. In radio, simplicity wins. Simple words, clear short sentences and a logical
structure are necessary to get information across. Radio scripts should be informal, direct and polite.
When you write your script and when you present it on the air, imagine that you are talking to one
individual listener - your neighbour, your friend or your aunt. T hink of how you would tell them the
information which you are about to give. T hink of that one concrete person. T alk as if you were
addressing just that one person. You will discover that your presentation will be much more direct and
animated.

Radio language should be very close to spoken language. Write as you would speak. However, this does
not mean that you can slip into colloquial slang (although some colloquial language can be dropped in
where appropriate). When writing your script, you should always know what language is appropriate for
your target group. You need also to keep in mind what your listeners’ religious, moral and ethnic
sensibilities are. What words are taboo? Carelessness can cause great harm and damage to your image
and credibility.

THE STRUCTURE OF A SCRIPT

Imagine that you have to take your listeners by the hand and lead them through the topic on a straight
path, without wandering off to the right or left. For your manuscript this means:

a strong introduction, catching the listeners’ attention,
then add the main facts, describe the background and further details,
and finally end with a conclusion and/or an outlook.

WHAT YOUR SCRIPT SHOULD LOOK LIKE
Only write on one side of the paper (avoids rustling when recording)
Leave generous space between the lines (to add pronunciation and intonation marks over or under
the words)
Make clear paragraphs - this visual aid will show you at a glance where to pause and take a breath
Write legibly (so the reader does not stumble over certain words or phrases that are hard to read,
or over unreadable corrections) - better yet, type up the final script
Read your text out loud while writing and you will find out immediately if the script "works" and will
avoid words that are hard to pronounce. T his will also help you to check the recording length.
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SPEAKING IN FRONT OF THE MICROPHONE

You chose the right format for your topic, you wrote a comprehensible and clearly structured text – now
you have to present it with your voice in an attractive manner.

Reread the text several times before recording to become familiar with it.
Conserve your voice, don’t stress it with tobacco smoke, alcohol or shouting.
Before reading, stretch your body as you would before taking exercises.
Also massage your face, neck and shoulders; open your mouth widely; massage your lips with your
tongue; relax by vibrating your lips against each other (as children do).
Speak in your natural, undisguised voice; don’t exaggerate or perform in a "wannabe"-voice.
T here are two rules for emphasizing words: 1. Emphasize words (usually: nouns) that are
outstandingly important in the text; 2. Out of these words only emphasize what is new in the text. If
you stick to these rules and the less you emphasize, the more you will sound competent and
credible.
T ry to relax when reading; adjust the setting in your studio to make it as comfortable for you as
possible.
In case of a slip of the tongue, reread the whole sentence (or even start with the sentence before,
you can cut it out when editing). But take a breath before starting, even several! Don’t hurry.
Ask friends for their feedback on your presentation. Appreciate their views – your friends are your
listeners!
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VOX POP
A vox pop is a short journalistic format, combining a variety of statements from ordinary people (latin:
vox populi = voice of the people) about a specific topic. Statements are oral, coherent thoughts, opinions
or explanations, to be understood without hearing the question. A good vox pop is informative and
entertaining.

CHARACTERISTICS
Offers a variety of different voices (male/female/young/old).
Offers a contrast of opinions (for and against).
Overall length: 1 to 1.5 minutes; length of each statement: 5 to 15 seconds.
In radio, the vox pop is usually combined with an interview or a report.

PURPOSE
T o reflect public opinion.
T o encourage people's participation.
T o provide authenticity and credibility.
T o make topics more lively and attractive.
T o overcome the gap between radio and listeners.

THE QUESTION
Should be personal (it should touch people's lives), current, relevant and immediately
understandable. A question that requires explanation won't work.
Firstly imagine what statements you might find – and what you want. Phrase the question
accordingly. 

RECORDING
Choose the right spot: semi-crowded, relatively quiet (no unwanted noise e.g. loud cars, music,
wind, planes). A place where people are at ease, not in a hurry.
Record, keeping any loud noises behind you (turn your back toward the noise). 
Don't record your question – you don't need it. Hence aim the microphone at the interviewee right
from the start.
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THE ENCOUNTER
Watch your body language - be self-confident and interested.
Introduce yourself briefly: greet, mention your name, your 'station', explain – in a sentence – that
you are asking people their opinion about the chosen topic, then ask your question.
Don't comment on the person's statement whilst they are speaking ("…aha… I see… right…"). Just
smile and nod encouragement.
Don't interrupt people. When they stop talking, wait two seconds to ensure they have really
finished their statement. Sometimes this encourages them to continue talking, and finally gives you
the statement you were looking for.
Re-phrase your question if necessary – but only change some words, not the topic.
Keep recordings short and snappy.
Don't ask interviewees for their names – they need to remain anonymous.
T hank the interviewees for their participation.

EDITING
Choose only interesting, audible statements in good recording quality that serve the goal you want
to achieve with the vox pop.
Choose a variety of 5-7 male/female, young/old, for/against, long/short statements.
Choose a strong start and end for the vox pop. T he first one has to be an attractive, ear-catching
statement. T he last one is the one the listener will remember.
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NEWS SUMMARY
Local news can be especially attractive for listeners – mostly because people are interested in what
happens in their neighbourhood. Proximity adds value to the news.

T here are two approaches to finding local news. Either something happens in your town/area, or you
find the local angle on a national or international news item. For example, a government or diplomatic
controversy between your country and a neighbouring country affects the citizens in your town who have
origins in the other country.

CHARACTERISTICS OF NEWS
T hey are topical issues
T hey are of general interest or of interest to a considerable audience
T hey are relevant to the listeners
Something that happens for the first time, or something that is the biggest or fastest, may also be
news
News may be tragic, or arouse sympathy, anger, or laughter

WHAT IS NEWS
Action taken by government, the opposition, parliament, political parties, NGOs
Political developments or decisions
Social developments, conflicts
Conferences, gatherings or demonstrations
Natural disasters
Accidents
Crime
Sports
T he unusual or extraordinary
Human interest stories
T he weather

WHERE TO GET NEWS
Ministers, officials, political leaders
Police
Hospitals
Press releases
Internet
Newspapers, magazines
Radio programmes
Personal contacts
T hrough personal observation
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TASKS OF A LOCAL NEWS EDITOR
Select the news items
Check the news items

On a local level it might be necessary to research facts that might result in news
Ask yourself: is the source reliable?
Cross-check the information: mention your sources in the text, especially when the information is
not fully confirmed.

Deciding the order of the news: the classical order is to start with political and economic topics and
proceed with cultural topics, sports news and human interest stories
Write the news
Present or record the news and make it available for callers

NEWS CONTENT

T he core of a piece of news is information that answers 7 questions:

Who was involved?
What happened?
When did it happen?
Where did it happen?
How did it happen?
Why did it happen?
What's the source?

T his information is called the "lead" and is the beginning of the news. T hen further details can be added,
the background of the news explained – but often there is insufficient time for details and background.

THE FORMAT OF A FREEDOM FONE NEWS BULLETIN

A Freedom Fone news bulletin has an overall length of about 2 minutes and includes 4 pieces of news,
each about 30 seconds long. Each bulletin starts with the sentence "T he news from … (town/area) on …
(day, week)".

NEWS CONTENT EXAMPLE

T he text below is an original text to work with - try to implement the tips and tricks throughout the
Content Production chapter to improve this text, then check it against how we improved it!

NEWS HEADLINES

In today’s news..T eachers threaten strike…Street vendors fight back…Evangelical churches
ban T B Joshua …Crocs attack 2. 

T eachers unions threaten to strike if salaries are not reviewed by government this month.
Reports from T he Daily News say that the unions differ about strategy but agree that long
standing issues regarding the welfare of teachers must be addressed urgently. 

Unions are demanding $538 a month for the lowest paid teachers, with additional
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allowances expected for those teaching in rural schools. Government has been slow to
respond in the past and many teachers believe strike action is their only option. 

T here was chaos in Harare’s city centre this morning when municipal police clashed with
street vendors. T he municipality is on a cleanup campaign to drive out vendors selling at
undesignated places. Some vendors resisted by throwing stones at the police as they
confiscated goods. Several people were injured in the incident. 

Evangelical churches in Zimbabwe say that controversial Nigerian prophet, T B Joshua, is not
welcome in the country. T hey say that T B Joshua’s teachings are a “deviation from the
Bible and more connected to occult practices”. T he spokesperson for the organizers of the
National Day of Prayer, Reverend John Chimbambo, yesterday said that the committee did
not normally invite foreigners to the National Day of Prayer set for May 25 this year. 

Zimbabwean fisherman, Frank T rott, was killed on T hursday by a giant crocodile after
attempting to rescue a friend near the Chirara fishing camp on Lake Kariba. T rott’s friend
was attacked by a crocodile whilst wading in the water late in the evening. T rott, aged in
his seventies, was seized by a second crocodile while responding to his friend’s cry for
help. T his is the second dramatic crocodile attack in a month. 

NEWS HEADLINES IMPROVED

Harare, May 10. In today’s news..T eachers threaten strike…Street vendors fight back…
Evangelical churches ban T B Joshua …Crocs attack 2. 

T eachers’ unions threaten to strike if salaries are not reviewed by government this month.
Reports from T he Daily News say that the unions differ about strategy but agree that long
standing issues regarding the welfare of teachers must be addressed urgently.

T eachers’ unions are demanding that lowest paid teachers receive a monthly salary of
$538. Additional allowances are expected for those teaching in rural schools. Government
has been slow to respond in the past and many teachers believe that their only option is to
strike. 

T here was chaos in Harare’s city centre this morning when municipal police clashed with
street vendors. T he municipality is on a cleanup campaign to drive out vendors selling at
undesignated places. When the police confiscated goods, some vendors resisted by
throwing stones. Several people were injured. 

T B Joshua, the controversial Nigerian prophet, is not welcome in the country say
Evangelical churches in Zimbabwe. T B Joshua has been invited by Prime Minister Morgan
T svangirai to attend the National Day of Prayer set for May 25 this year. T he spokesperson
for the organizers of the National Day of Prayer, Reverend John Chimbambo, says that T B
Joshua’s teachings are a “deviation from the Bible and more connected to occult practices”.

Zimbabwean fisherman, Frank T rott, was killed on T hursday by a giant crocodile after
attempting to rescue a friend near the Chirara fishing camp on Lake Kariba. T rott’s friend
was attacked by a crocodile whilst wading in the water late in the evening. T rott, aged in
his seventies, was seized by a second crocodile while responding to his friend’s cry for
help. T his is the second dramatic crocodile attack in a month. 

T his is the news, Harare May 10. 
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WHAT WE DID
We put the important stuff at the end of the sentence! T his is what the listeners will remember
most.
We shortened the sentences and changed the presentation of the news to make it easier for the
reader. Do remember to type out the final copy for reading!
We timed our reading to ensure that we did not run over allotted time.
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EXPLANATORY REPORT
For all kind of reports, the same rules apply as for news: journalists have to stay objective. T heir
language must be precise and easy to understand. T he words they choose have to be neutral, not loaded
or emotional. T he aim of a report is to inform the listeners objectively, to tell both sides of a story. T his
way, the listeners can form their own opinion based on the arguments and views presented.

CHARACTERISTICS OF AN EXPLANATORY REPORT

In a report, the journalist tells the listeners about an event or issue and the various views and positions
the key players have on it. Usually reports, like news, start with the most important core and proceed to
other main facts, details, then background information. While reports usually focus on current affairs, in
an explanatory report the listeners may get information about an issue that is not new (e.g. an epidemic
that has already lasted for weeks). Despite this, the topic and the information should be relevant and
beneficial for listeners, otherwise they won’t listen. T his kind of report is more of a service for the
listeners than a news story on current affairs.

RULES FOR THE EXPLANATORY REPORT
A longer report, read by only one journalist or narrator, can easily come across as monotonous
and boring. It is recommended that an explanatory report should not exceed 2 minutes.
Choose to use the form of the explanatory report when you are required to inform the listeners
about the background, connections and contexts of a topic.
Keep in mind the rules for script writing (see our chapter on Script Writing): the more complex the
topic is, the more simply it must be presented.
Be aware of the format of your script: use subheadings, bold text, paragraphs, bullet points. T he
clear structured format should correspond to the clear structured content.
Don’t write a dictionary entry, but try to find an interesting beginning to your text mentioning your
topic and linking it to your listeners’ lives. 
Skip information that is not useful.
Keep your listeners as the forefront - if they want to know what to do in order to avoid a life
threatening infection - tell them in the first sentence, and repeat it every now and then because it is
crucial!

EXPLANATORY REPORT SAMPLE

T he example below is the original text for a health information service around cholera. See what
changes you would make, and then refer to the next example showing the changes we made.
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CHOLERA INFORMATION

Cholera is a very infectious disease which causes severe diarrhoea. Cholera is spread by
eating food or drinking water that has been contaminated with Cholera germs. Once
someone is infected, the symptoms usually develop within hours or days. T he symptoms
include extremely watery diarrhoea that is whitish in colour, like the colour of water from
cooking rice. Cholera diarrhoea is painless, there are no cramps or other pains like other
cases of diarrhoea. T here is no fever associated with Cholera and vomiting is common.
Cholera does not cause blood in the faeces. 80 % of infected people get either mild, normal
diarrhoea, or do not show symptoms. T he severe dehydration associated with Cholera can
cause death. T he best form of Cholera prevention is to establish good sanitation and waste
treatment systems. In the absence of adequate sewage treatment, follow these simple
rules: if you can’t boil, cook or peel it – forget it. Here are some other tips: Always try to
defecate in a sanitary place, and far away from water people will use for drinking, bathing.
washing or watering their crops. You save water to wash your hands and wash your hands
after going to the toilet. Also wash your hands before cooking or preparing food. Don’t eat
food that you can’t trust. Fruits that can be peeled, such as bananas and oranges are fine,
but remember to wash your hands with soap before peeling them. T ry to drink save water
only. Ideally it will have been boiled for three minutes. If this is too difficult even filtering the
water through a cloth greatly reduces the chance of Cholera. T he ideal cloth is a fine
woven cloth. But a cotton sheet or t-shirt folded over 8-10 times might be the best you can
do. Most people who are infected with Cholera have no symptoms but are still excreting
their germs in their normal stool. So always be careful. 

CHOLERA INFORMATION IMPROVED

What is  Cho lera? 
Cholera is a very infectious disease that is spread when the stool of infected people
contaminates food and water. T his can happen if people relieve themselves near food and
water sources. Another common cause of infection is handling food after handling food
after without washing your hands. Cholera causes severe diarrhoea. Diarrhoea is
uncontrollable watery shitting that can lead to death. 

Signs  o f  Cho lera 
Once someone is infected, the signs usually develop within hours or days. T he signs include
vomiting and extremely watery diarrhoea that is whitish in colour, like the colour of water
from cooking rice. Cholera diarrhoea is painless. T here are no cramps or other pains like
other cases of diarrhoea. T here is no fever associated with Cholera. Cholera does not
cause blood in the stool. 80% of infected people get either mild, normal diarrhoea, or do
not show signs. Dehydration, which is the excessive loss of water from your body, can
cause death. 

Ho w to  prevent inf ectio n

Always wash your hands before cooking, preparing or eating food.
Don’t eat food or drink water, if you can’t boil, cook or peel it. Examples of safe food
are fruits that can be peeled, such as bananas and oranges.
Safe drinking water should be boiled for three minutes.
You can also filter the water through a cloth to reduce the chance of Cholera. Ideally
use a fine woven cloth. If you don’t have one, use a cotton sheet or t-shirt folded 8-
10 times.
Always try to relieve yourself in a clean place well away from water sources used for
drinking, bathing, washing or watering crops.
Make sure to save clean water to wash your hands after using the toilet.
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Most people who are infected with Cholera show no symptoms but can still spread germs
in their stool. Cholera can kill – so always be careful.

155



MICRO AUDIO DRAMA
One of the ways to be more creative with your audio content is to produce micro audio dramas, which
when done well, can be compelling and interesting while delivering an important message. Each episode
should be no more than 2-3 minutes in length.

OUR TIPS
T ake advantage of local dramatists, particularly those with some experience in "drama for change" for
radio - writing dramas for audio is quite difficult, where you have only a voice to convey an idea, no
gestures, clothes or facial expressions.

Use local actors or radio voices - they will have some experience with conveying a message using tone,
pitch and speed, and this may significantly reduce your recording time. It may also offer the secondary
benefit of having your audience recognise a well-known voice and increase the popularity of the service.

Limit the number of characters and the complexity of the plot. We recommend a maximum of 4
characters. Choose actors with voices that will be easier for the listeners to differentiate between -
young, old, male, female, high voice, low voice etc.

Avoid background noises e.g to illustrate that your actor is entering a bar - these can be confusing over a
telephone and your message may well be lost. Also avoid large blocks of extraneous material e.g lead-in
music - if your audience is paying for the call, these wasted periods will be annoying.

Repeat important messages as often as possible without being boring - just in case someone misses the
point through an intermittent connection.

Depending on your format, it is best to offer several shorter episodes as opposed to one long drama. In
the event a caller runs out of airtime, or loses his connection, they can call back and go directly to the
episode they wish to hear - without having to start from the very beginning all over again.

You may wish to make all episodes available immediately - to maintain audience interest and reduce your
advertising costs. Large intervals between episodes may result in callers having forgotten previous
episodes / the number to call / when the next episode begins etc.
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WORKING WITH VOICE MESSAGES
Freedom Fone's Leave-a-message (LAM) functionality allows callers to leave a voice message with your
service (for detailed information refer to the chapter Leave a message in the Freedom Fone User and
Advocacy Guide).

Callers’ audio messages can be titled, tagged, categorised and rated. T hey can also be archived if
required – in message edit view the status field can be used for this purpose. Each audio message can be
exported as an .mp3 file using the download icon . 

T here are many ways to make use of this feedback:

Always respond to feedback when you are required to do so - this will build caller loyalty and a positive
perception of your service. Using the information you receive, acting on it and informing your audience is
the single most important aspect of a successful LAM deployment.

If using Freedom Fone in conjunction with radio, you can re-broadcast the feedback you receive. Be sure
to choose messages that are clear and audible. You may want to choose messages that are varied in
opinion and representative of your audience.

You can choose to edit the messages you receive to make a vox pop around a particular topic (refer to
the chapter on Vox Pops). Your audience can then call in and access the vox pops via the IVR. 

You can choose to edit the messages you receive to create a podcast for your website.
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THE DIY STUDIO
T his chapter is about building your own recording studio. With a few steps you can easily improve the
quality of your recordings.

WHAT DO I NEED?
A SILENT ROOM

Avoid all kind of noises eg fans, phones, computers or other humans...
Choose the best sounding place in the room by walking around and speaking aloud as you go.

T ry to find a place that sounds very dry.
Check out the corners of the room - usually you will have less echoes there than in the middle of
the room.
Do your best to shelter this place from other noises using sound absorbing materials.
Hard surfaces like glass or stone walls cause reflections, so cover them with something soft like
foam or blankets, especially at the place where you want to record.

If you are sitting on a chair, take one that cannot swing or move to avoid unwanted sound.
Close doors and windows while recording.

A MICROPHONE

If possible use an external microphone for your recording. T he sound quality is usually better than
that delivered by a field recorder. T he microphone can be connected directly to your recorder or to
a software audio interface connected to your computer.
Use a wind shield or a pop shield to avoid popping sounds.
Follow the rules in the chapter on Recording Techniques to get a good recording.

A MIC STAND

Holding the mic in your hand can cause noises. Rather use a tripod that you can put on a table or a
mic stand at which you can stand while recording.
If possible place the stand on something soft (like a carpet) to avoid noises from the floor.

HEADPHONES

Always use headphones while recording. T hey are important for judging the sound quality of your
recording.
You will hear more precisely with closed cup headphones than with earplugs or cheap headsets.

A COMPUTER

Installed with audio editing software like Audacity - http://audacity.sourceforge.net, Hindenburg -
http://hindenburgsystems.com, or something else to edit your recordings. Read the Audio Editing
chapter for further information.
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RECORDING EQUIPMENT

THE FIELD RECORDER
Keep your equipment clean, dry and safe.
Know your equipment: make test recordings, check the settings, rehearse interviews and
recordings
Use an external microphone (if available)
Always use headphones to check the sound quality when recording 

RECORDING SETTINGS
Mono
WAV 44.1 PCM (frequency rate = 44.100 Hz). If only mp3 is available, the bitrate should be 192 kbps.
Switch off automatic gain control (AGC), but use the limiter if you can switch it on separately.
Switch on the Low Cut or High Pass (HP) option on your device. T his will cut out disturbing low
frequencies like pop sounds or footsteps.
Use your eyes and your ears to check the recording:

1. T he recording level meter will inform you about the overall level.
2. T he headphones will inform you about the sound quality; the balance between

background and foreground disturbances/noise.

Find the appropriate recording level by prerecording rehearsals in the same setting or surroundings
in which the final recording will occur. Make sure to let the interviewee talk into the microphone
whilst you can check the level, before recording the interview.
When using an internal microphone, use the cardioid characteristic (if available).
Always take spare batteries with you.
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RECORDING TECHNIQUES
T his chapter is about creating high quality recordings and how to avoid disturbing noises. T he following
points are valid for all kinds of recording devices, whether you use a recorder with an external
microphone or one which is integrated into your field recorder.

When recording for Freedom Fone, remember to accommodate the 1-2 seconds it takes someone to
choose their menu selection and put the phone back to their ear. T his time can be filled with a jingle or a
short introduction, ensuring the caller does not miss the first few words of your message. 

INTERVIEWS / SPEECH

IN A ROOM

Choose an appropriate room e.g. furnished, carpet on the floor, curtains, few windows.

Avoid disturbances e.g. fan, computer fan, AC, open windows, ringing telephone.

Choose a position in the corner of the room.

Stand in front of the interviewee. T his is better than sitting at a table.

T he microphone should point into the corner, so place the interviewee accordingly.

Hold the microphone correctly. For most mics, a distance to the mouth of 10-20 cm is appropriate.

Never let the interviewee hold your microphone because you will lose control over the recording.

Hold the mic quietly. Remove bracelets and rings to avoid accidental noises caused when they
jangle or knock against hard surfaces.

Whenever possible, use a wind shield to cut out the low frequency noises produced when air hits
the membrane of a microphone.

When recording digitally follow these rules of thumb: 
T he recording level should never reach 0  decibe l (dB). Levels over 0 dB produce distortion
which destroys the recording and reduces audibility.
We recommend that peaks reach no higher than -6 dB. 

Always use headphones to check the sound quality (see Content Production).

Don't forget to start the recording!

Check the recording level every now and then – but maintain eye contact with the interviewee. 
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Good recording technique inside a room 

  
Bad recording technique inside a room 
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Good recording technique inside a studio 

    
Bad recording technique inside a studio 
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OUTSIDE

Choose an appropriate location in order to avoid unwanted noises/disturbances e.g. loud cars,
aeroplanes, music, wind.

For vox pops, choose a “semi-crowded” place, with vivid background sounds (footsteps, people
chatting) and where people are relaxed and not in a hurry (avoid rush hour).

Hold the microphone away from disturbing noises (most importantly, traffic).

Don't forget to start the recording!

Check the recording level every now and then – but maintain eye contact with the interviewee.

  
Good recording technique in the field 
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Bad recording technique in the field

SOUNDS
Record clear, short and recognisable sounds (e.g. knocking at a door, footsteps, a breaking
window). Avoid complex, longer and ambient sounds.

Approach the source and get as near as possible with the microphone  – but avoid reaching 0 dB
(see above).

If possible, make several recordings to find the best recording level.

Avoid anything that could distract or confuse the listener (e.g. loud noises in the background).

Don't mix sounds with speech, they should stand alone to keep the speech clear and audible.
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AUDIO EDITING WITH AUDACITY
T his chapter is about editing your recordings with Audacity 2.0 to produce a vox pop. Of course there are
other editors on the market that you can use instead. T he following steps should be compatible with
most of them.

Before you start editing, choose a volume setting on your speakers that is not too loud and not too soft,
to listen to your recordings.

SETTING UP YOUR PROJECT
First copy the files from your recorder to a folder on your computer
Import the files into Audacity via the File > Import function or drag and drop the files into an Audacity
window. Audacity will create a track in your project for each file you import.
Stereo files will be opened in a two channel track in Audacity. 

Since the Freedom Fone software only handles mono files, we will need to change these tracks
from stereo to mono.
Press Ctrl+A to select all tracks and then use the Tracks > Stereo Track to Mono function. Now all
tracks have only one channel.

LEVELS AND EDITING

  

Use the Solo toggle button to the left of a track to listen to only this track. T he activated track
becomes blue, the other ones turn grey. 

  

Use the Selection tool to highlight the entire audio file of one track. 
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Use the Normalize effect - Effect > Normalise - to normalize the selection to -2 db. T his will set the
highest peak of your audio file to -2 db. 

  

Set the volume level on your speakers to a comfortable level for this track. T his should now be
your reference setting for all of the other tracks. 
Use the Selection tool to select a part of the file you want to delete. T o change the selection move
left or right to the outer borders of the selection and use the Hand tool that is automatically
displayed.
T o get a closer look at the wave shape of your recording use the Zoom In, or Zoom Out functions
to get a better overview. You can also use the Ctrl key and your mouse wheel. 

  

If you want to keep only the selected portion, use the T rim function (Ctrl+T ). T he rest of the audio
file will be deleted.
If you want to delete the selected part and keep the rest, use the Cut (Ctrl+X) function
If you want to split the recording into two clips use the Split function (Ctrl+I)
After editing your audio file Normalize it again to -2db to get a higher level
If there are still peaks in your audio file that prevent your recording from achieving a higher level,
you should select these parts and edit them further. Reduce their level to the average level of your
recording via Normalization. 
If there are no peaks left you are ready to Normalize one last time to -2db. It is very important to
get a regular high level!
When your first piece is done, save it by selecting the area and choose the File > Export Selection
function. Give the file a new name and store it in your folder.
Now deactivate the Solo setting for this track. T he waveforms will change colour from blue to
grey. 

T ake the next file on the following track and repeat these steps again.

HOW TO DO AN ARRANGEMENT

At this stage you should have several tracks with edited recordings. T he next step is to make an
arrangement with them.

In our example we have five mono tracks. For our arrangement we need only two. So you will use the
Move tool (also called the T ime Shift T ool) to relocate the recordings from the bottom tracks to the two
tracks at the top.

Arrange the clips alternately on the two tracks: the first clip on the first channel, the second on the
second channel, the third on the first, the fourth on the second and so on... Read the chapter Vox
Pop for more information on how to create variety within a vox pop.
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Delete the unused tracks to provide more space on the screen. Use the X button in the top left hand
corner of the track. 
Use the Move tool to adjust the position of the clips so that you don't have gaps between them.
However, if you need to add breathing space between clips, you can do so by increasing these
gaps. 
Use the Fade tool (or Envelope tool) to create smooth crossings between the clips. With the Fade
tool selected, a left mouse click on the blue line on the top of the clip will create a fade point.
Now drag the blue line down between the fade point and the border of the clip to adjust your fade.

  

Create short fades for each clip at the start (Fade in) and the end (Fade out) to get a nice flow.
Arrange the clips on the two tracks so that there is an overlap between the fade in and fade out
sections. See the screenshot below. 
Listen to your arrangement one more time to check the levels. T he goal is to have a constant level
across the whole piece. 

  

Fade in and Fade out with overlap between tracks
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EXPORT, EFFECTS AND TESTING

If you are really satisfied with your arrangement, save the entire project with File > Save Project as.
Give it a useful name and save it to a location where you can find it again. T he project file will have
a .aup extension and will include all edited audio files and your arrangement. If you want to
rearrange or edit something later, just open your project again.
Before mixing your arrangement to create a new audio file, change the project sample rate to 8000
Hz. Look for the Project Rate drop down list in the bottom left hand corner of your screen. 

  

Use File > Export to export the arrangement to a .wav file with settings that ensure the final file
format is 8000 Hz, mono, wav. T he file size should be less than 10 MB. 

You will be shown a form to add Metadata if you wish, but this is not required to proceed. 

If you have followed the steps correctly so far, you will see a warning that your mixdown will be
exported as a mono channel. Press the OK button. 

  

Close the current project and open a new one (Ctrl+N).
Import your new mixdown file to the project.
Choose Effect > Leveller and set 'Degree of Leveling' to Heavy. T his will increase the loudness of
your mixdown and improve audibility for your callers. If you're not happy with the result, do it a
second time with a Moderate setting. 

  

After production, upload the file to a Freedom Fone Voice Menu and listen to it on the phone! Listen
through the whole file carefully to ensure everything is understandable.
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T o be thorough, make sure that you can exit the audio playback by pressing any number on your phone's
keypad. You should be returned to the instruction menu. If there is a problem, check your Audacity export
settings. T hey should be 8kHz, mono, wav.
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AUDIO EDITING WITH HINDENBURG
T his chapter is about editing your recordings with the Hindenburg Journalist Pro Version 1.21 to produce
an explanatory report.

Before you start editing, choose a volume setting on your speakers that is not too loud and not too soft,
to listen to your recordings.

Before using Hindenburg for Freedom Fone purposes you must define your default settings:

Go to Tools > Options > Audio where you define the recording and playback channel of your sound
card.
From there go to the Advanced T ab and change the station profile to US Mode. T his will set your
default auto level to -6db. 

Download and unzip the free Lo udMax VST-Plugin from http://loudmax.blogspot.com/ 
Copy the .dll file to C:\Program Files\Steinberg\VSTPlugins. If the folder is not already there, just
create it manually. After installation, restart Hindenburg and it should discover the new plug-ins in
the Ef f ects  bin. T o view the Effects bin, click the icon circled in the image below, then click
anywhere in the Effects panel that pops up. 
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SETTING UP YOUR PROJECT

First copy the files from your recorder to a folder on your computer
Open the Hindenburg application
Import one file after the other to your project via File > Import or drag and drop into one of your
tracks. Notice that you only can import one file at a time. Hindenburg will automatically set the level
of your file to the defined setting of -6db (like the Normalize function of Audacity).

BASIC EDITING

Hindenburg is nondestructive editing software. T hat means whatever you do with your recording, you
will not touch or destroy your original file.
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Editing in Hindenburg is all done in one view. You can move, trim, gain and make selections. T he cursor
will change depending on where you are in the region. 

EDITING EXERCISE USING SAMPLE FILES 

In our example we have two files. One large audio file from a female voice and a short one with the
headlines from a male voice. T his means we need only two tracks for editing.

You can delete tracks with a right mouse click in the control area of your track on the left hand side of
the screen. 
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Zoom In and Out horizontally with the In and Out Option from the toolbar, or by holding the Ctrl Key and
using the Mouse wheel. T o zoom vertically hold Shift + Ctrl + use the mouse wheel. 

T o move a region just select it by clicking on it (colour turns from blue to orange). With the cursor in the
upper part of the selection, drag the region to the new location.
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AUDIO EDITING EXAMPLE

First we will clean the recording of the headlines. T o trim the beginning of the recording grab the
left border of the region and move it to the right. Do the same with the right border to shorten the
end. 

T o delete spaces in between the headlines, just drag a selection at the bottom of the region and
use Edit > Clear or press Del on the keyboard. 

If you want to delete AND close the gap in one action, make a selection and use Edit > Cut or Ctrl+X.
Use Edit > Split or Ctrl+B to separate one region into 2 regions the current position. You can also
split a selection at the In and Out Point. 
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Create Fades at the borders of your regions using the fade points in the upper corner. 
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You can co py regions of audio to the Clipboard on the right hand side by holding the Ctrl key and
dragging the files into a group in the Clipboard panel. You will see the cursor change to a + symbol
as you move into the Clipboard panel. You can rename the copied clip by right clicking the file name
in the Clipboard panel. T his is a very useful tool for keeping your workspace organised. 

If you want to, you can delete the regions/clips from the main edit panel and copy them back from
the Clipboard later. 

T ake the BrendaT ext file and clean it by deleting the paragraph repeated at the end of the
recording.
If you want to Group clips/regions select the first one hold Shift and select the last one. All regions
in between will turn orange. Press Ctrl+G. Now you can move all regions together.
T o adjust the volume of a region manually grab the top of the region and drag it up and down to
raise or reduce the level. 
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Once you have finished editing, select all the regions by clicking the first one, holding the Shift key
and clicking the last one. All regions will turn orange. Use the Tools > Auto Level function or Ctrl+L to
normalize all regions at the same time. Now you should have a good balanced level of -6 db in
average. 

At the end of our production we must raise the loudness of our piece to enhance the speech clarity for
telephone networks. 

Add a Master Track to the project with a right mouse click in a free area in the grey left hand margin
under the other tracks. All other T racks are routed to this Master T rack. 
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Load the LoudMax plugin into the effect bin by clicking on the 'fader' symbol of the master track
(see image towards the beginning of this chapter) and choosing one of the four empty effect slots.
Choose the T homas Mund LoudMax Plugin with the settings below:

T hreshold: -15db
Output Level: -1db

Save and then Export your Project with the following settings: 
Mono, wav, choose 8 kHz Sample rate from the options dialog 

After production, upload the file to a Freedom Fone Voice Menu and listen to it on the phone! Listen
through the whole file carefully to ensure everything is understandable.

T o be thorough, make sure that you can exit the audio playback by pressing any number on your phone's
keypad. You should be returned to the instruction menu. If there is a problem, check your Audacity export
settings. T hey should be 8kHz, mono, wav.
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USEFUL LINKS
http://hamchatforum.lefora.com/2009/10/19/how-to-write-a-radio-script/ 

http://www.makeuseof.com/tag/5-online-resources-aspiring-scriptwriter/ 

http://news.bbc.co.uk/2/hi/school_report/6180944.stm 

http://www.mediahelpingmedia.org/training-resources/journalism-basics/646-tips-for-writing-radio-news-
scripts 

http://www.audiotheater.com/resource.html
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SUPPORT
If you need help, check out our fantastic resources designed to help you make the most of Freedom
Fone.

WEBSITES

http://www.freedomfone.org - main project website 
https://dev.freedomfone.org - development website 
http://demo.freedomfone.org - online demo

COMMUNITY FORUM

http://freedomfone.org/forum

FACEBOOK

http://www.facebook.com/freedomfone

TWITTER

@freedomfone 
http://www.twitter.com/freedomfone
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FAQS
T his chapter aims to address frequently asked questions relating to Freedom Fone.

CAN I USE THE FREEDOM FONE COMPUTER FOR OTHER
THINGS?

It is recommended that the Freedom Fone computer is only used for Freedom Fone. T his is because
Freedom Fone is resource intensive, and so if other applications are sharing the system resources, this
may interfere with the calls.

WHERE CAN I GET TECHNICAL SUPPORT?

Please see our "Support" chapter for information on how to get answers to your questions.

WHY DOES THE MENU OPTION SELECTION NOT APPEAR TO
WORK? 

Some mobile carriers do not send the DT MF (the tone when a key is pressed) correctly, and Freedom
Fone is unable to determine what selection the caller has made.
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A p p en d ices
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INTRODUCTION TO MOBILE PHONE
SECURITY
Most people have mobile phones today. In the past these devices were primarily used to call and send
text messages. In addition, all mobiles have at least an ability to keep an address book. T here is a new
generation of mobile devices that come with Internet access, built-in video cameras and the ability to
install additional software. T hese smart phones can be very convenient and provide you with very
powerful and useful tools. T hese phones contain a lot of private data and, unfortunately, a phone can be
lost easily. T he following chapter deals with some methods to use them more secure.

SECURITY ISSUES WITH MOBILE PHONES

Phys ical security - A phone can be confiscated or stolen. If you are a journalist, your address book
might be of special interest: it can be used just to gain knowledge of your network or for further social
engineering. As a minimum safety measure you should always enable some kind of password protection
on your phone (not just on your SIM card).

Vo ice  - Although the voice on a GSM (mobile phone) channel is encrypted, this encryption was hacked
some time ago and is not considered safe any more. Furthermore, if you do not trust the network(s) you
are using it has never been safe. Normal VoIP communications are very insecure as they are not
encrypted. Some other VoIP services use some kind of encryption.

SMS - T ext messages are sent in plain text over the network, so they are also not considered secure,
additionally they are not securely stored at your device, so anyone with access to it will be able to read
them. If you are using an Android based phone read the chapter on 'Secure T ext Messaging'

Smartpho nes  - Smartphones are quite new, and unfortunately most advanced (and even some basic)
ways of securing that are available on normal computers are not available on smartphones. T hey pose
additional risk since you are also using them for things like agendas, and personal note taking. Also not
all applications in an appstore or market are safe to use, because there are a considerable number of
malware apps on the market which are passing your personal data to other companies. You should
always check if the app's you want to use can be trusted. Internet on your mobile device is subject to the
same problems as all wireless communications. Read the chapter on VPN for mobile devices to improve
this.

Prepaid s im cards  - In some countries you are still able to use prepaid locally bought SIMcards without
identifying yourself. Beware that your phone also has a unique identifier (known as the IMEI number) so
switching SIM cards will will not guarantee to protect your privacy.

T he following chapters will deal with different methods that are available today to secure your mobile
communications. Note that mobile phone security in particular is developing very fast and users should
check out the current status of premier open source efforts like the Guardian Project
(guardianproject.info).
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FREE SOFTWARE?
Freedom Fone is Free  So f tware  - this means it is developed by a community and licensed in a generous
way so you can use it for free for whatever you want.

Free Software (sometimes also referred to as Free  and Open So urce  So f tware , FLOSS, FOSS,
So f tware  Libre , or Open So urce ) is software that anyone can download, share, and -- significantly --
change in any way they want. Practically speaking, you might never want to change the software, or even
have a staff person who can read the so urce  co de  (the instructions written by programmers). But the
ability to change the software protects you in many ways:

Freedo m Fo ne  will not go away, unlike non-free software from some companies that gets
abandoned if the company goes bankrupt or decides to discontinue specific product.
T he software can be used and customised free of charge.
Nobody can suddenly take away features or change the terms under which you're allowed to use
features.
If an organisation wants a feature that Freedom Fone doesn't provide, the organisation can just
hire someone to create it. Of course, the organisation can also submit a feature request to the
Freedom Fone team as with any software product.
Similarly, anyone can fix a bug  (error in the software) if he or she has the skills to do so. Because
the source code is available, clients can also find bugs more easily.
Members of the community have much more input into how Freedom Fone develops, because they
can understand the product by reading the code and can make changes. Furthermore, many people
can try different implementations of features and the community can decide by vote or consensus
which one to make official.

T hat may be enough for you, but for the sake of completeness we'll offer some widely used definitions:

"Free  so f tware  or so f tware  libre  is software that can be used, studied, and modified without
restriction, and which can be copied and redistributed in modified or unmodified form either without
restriction, or with minimal restrictions only to ensure that further recipients can also do these things and
that manufacturers of consumer-facing hardware allow user modifications to their hardware. Free
software is available gratis (free of charge) in most cases." 
(from: http://en.wikipedia.org/wiki/Free_software)

"Open so urce  so f tware  (OSS) is defined as computer software for which the source code and certain
other rights normally reserved for copyright holders are provided under a software license that meets the
Open Source Definition or that is in the public domain. T his permits users to use, change, and improve
the software, and to redistribute it in modified or unmodified forms. It is very often developed in a public,
collaborative manner." 
(from: http://en.wikipedia.org/wiki/Open_source_software)

Nearly any software that qualifies as free also qualifies as Open Source, and vice versa. T he main reason
that two different terms exist is that "free software" emphasizes the freedom aspect (that you aren't
under the control of the original programmers) whereas "open source software" emphasizes the
convenience and potential for innovation provided by having the source code available.

When you install and use Freedom Fone, you'll notice there's no annoying click-through so f tware
license  imposing a thousand things that you can or cannot do with it. T hat's because free software
doesn't limit your right to do with the software whatever you want. Free and open source software have
licenses, but they're simpler than and quite different from pro prietary so f tware  ('closed software')
licenses. Freedom Fone itself is available under the Mo zilla Public License  Vers io n 1.1, one of the
popular free software licenses used by many other projects.
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FREE SOFTWARE AND NON-PROFITS

Explaining all of the possible considerations on using FOSS in non-profit and advocacy work might take a
really long time, so let's focus on the most important highlights:

One of the priorities of FOSS projects, including Freedom Fone, is to involve the community of
users in the process of designing and building the software. In the long run, this not only assures
that the software is doing exactly what it should do to sustain the needs of its users, but it also
allows indirect exchange of knowledge and experience between organisations. By using Freedom
Fone, you're basically taking advantage of other non-profit and advocacy practitioners' experience.
Having access to the source code gives you and your organisation certain independence. With
proprietary software it's usually impossible to customise the tools to meet your specific needs.
With FOSS, you can hire a developer or consultant and work with them on providing specific
functionality needed in your work. Additionally, if you contribute your improvements to the project
community other organisations will most probably start using them. It means you can receive
testing and further improvements of your functionality.
When a company which provided you with a closed software goes out of business, the usual
procedure for an organisation reliant on that software is to abandon the software and start
investing in a new one (which is resource intensive and costly). It's less likely to happen with Free
and Open Source Software - there is always a community of users and developers around it and
there is no single "point of failure". With FOSS projects, if the main organisation behind a specific
piece of software shuts down or changes their focus, the community takes over, a new
organisation is formed and the software development and support continues.

Apart from the quite practical advantages listed above, there is also a more philosophical approach to
answering the question of importance of FOSS for non-profits and advocacy organisations. Without
getting too deep into philosophical discussions, there is a great overlap between values shared by non-
profit organisations and these shared by Free and Open Source Software communities. By working with
the community of users, providing your feedback, contributing your changes back into the project, you're
actually strengthening the non-profit sector.

FURTHER READING

Free  So f tware  Fo undatio n 
http://www.fsf.org/

The  Free  So f tware  Def initio n 
http://www.gnu.org/philosophy/free-sw.html

Open So urce  Initiative  
http://www.opensource.org/

The  Open So urce  Def initio n 
http://www.opensource.org/docs/osd

Cho o sing and Us ing Free  and Open So urce  So f tware : A primer f o r no npro f its  
http://www.nosi.net/projects/primer
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ABOUT THIS BOOK
T his guide was authored together in November 2011, over a six day period in Nyanga Zimbabwe, by a
team of 11 people drawn from 6 countries.

Kubatana brought us together, mined the contents of our heads, the experiences of literally thousands of
others who are part of the Freedom Fone story and the support of donors and well wishers who have
believed in the Freedom Fone ethos.

For many of us who have been used to the processes of creation taking months and sometimes years
the tool and process we used called Booksprint was a revelation. Individual thought and writing, two
person teams, pow wows of the whole team fueled by respectful argument, disagreement, eventual
compromise and recommitment to the task of finishing the guide to deadline all led to a roller coaster
ride that was exhilarating and satisfying.

Seven hundred hours of our collective effort has produced around thirty thousand words of description
and many illustrations that we hope is a coherent whole and a useful tool to help you use this fantastic
software called Freedom Fone.

T he story is never complete and your contribution can help us to improve this manual and 'keep it live'.
By using Freedom Fone, testing this guide out and letting us know how relevant it is - you too will
become an author of something that really does help many others!

You will join that community of Free and Open Software developers and users that are changing
paradigms of ownership and control of information and tools. We welcome you and your contribution
and wish you well in your journey with Freedom Fone!

T he spirit of Ruparara be with you!
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GLOSSARY

A

Alliso n Vo ice  - A female voice used by Cepstral Voice for voice synthesis.

API - Application Programming Interface - An interface employed by a software application to enable
interaction between itself and other software.

Archive  - A file, usually compressed, containing multiple files.

B

Backend Sweeper - A service that runs behind the scenes to remove caller records and logs from the
system at regular intervals.

BIOS - Basic Input Output System, provides low-level computer configuration.

Bug  - Program behaviour other than expected or desired.

Bug Repo rt  - Usually an e-mail or an entry in a bug database asking for help with a specific bug. Good
bug reports state what software was used (Linux distribution and version, application name and version),
what the user tried to do and what was the expected result, what happened instead, and what the user
tried in order to fix it. It is particularly helpful to explain how to reproduce the problem, if it is repeatable.
Log files of the incident should be attached.

C

Cache  - A cache is a part of an information-processing system used to store recently used or frequently
used data to speed up repeated access to it. A Web cache holds copies of Web page files.

CDR - Call Data Records

Cepstral Vo ice  - A voice synthesis service to convert text into audio.

Co mmand - Executable file or shell builtin.

Cro n or cro njo b - A command to be executed automatically on a schedule set with the cron command
or one of its variants, such as anacron.

Cro sso ver Cable  - A computer network cable that is used to connect two network devices directly to
each other without the need for a network router.

CSV - Coma Separated Value - A simple format for a spreadsheet. CSV files are text files where each cell
is separated by a comma, and each row is separated with a return. T his very simple format is
understandable by many different programmes.
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D

Def ault  - A value that is used when an input has not been provided.

Demo  s ite  - A website that allows you to test and explore the functionality of a piece of software.

DTMF - Dial T one Modulation Frequency. T he tone that is made when a key is pressed on a telephone
during a call.

F

Fire f o x - Firefox is the most popular free and open source Web browser, developed by the Mozilla
Foundation. 

FLOSS - Free/Libre Open Source Software, licensed so as to guarantee the essential freedoms of
software users to source code and reuse. A combination of Free Software and Open Source Software,
with Libre added in to emphasize that software freedom is essentially a matter of rights, not price.

Fo rum - A web-based online discussion tool.

Freedo m Fo ne  Service  - Describes the information service an organisation is providing for a target
audience using Freedom Fone.

FreeSWITCH - T he technology used to handle incoming calls and direct them to the appropriate
destination.

Fro ntend Sweeper - A panic button that is used to replace all caller identity information
with arbitrary values.

Functio nality - T he set of tasks that a piece of software can perform.

G

GBV - Gender Based Violence

Gedit  - A simple and easy text editor for GNOME. It is UT F-8 compatible, provides tools for editing
source code and can be extended using plugins.

GSM - A technology used behind mobile communication

GUI - Graphical User Interface - User interface offering windows, icons, mouse control, multiple fonts,
and so on.

I

ICT - Information Communication T echnology

IMEI - An unique identification number used in all GSM devices, similar to a serial number.
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IP Address  - Internet Protocol Address - An IP address is a number identifying a particular computer on
the Internet. In the previous version 4 of the Internet Protocol an IP address consisted of four bytes (32
bits), often represented as four integers in the range 0-255 separated by dots, such as 74.54.30.85. In
IPv6, which the Net is currently switching to, an IP address is four times longer, and consists of 16 bytes
(128 bits). It can be written as 8 groups of 4 hex digits separated by colons, such as
2001:0db8:85a3:0000:0000:8a2e:0370:7334.

ISO  - A copy of the contents of a media (typically a CD or DVD) for downloadable purposes, and is then
used to create copies.

ISP - (Internet service provider) is a business or organization that provides access to the Internet for its
customers. 

IVR - "press 1 to access your account, press 2 to speak to a representative ..." T he term IVR refers to phone
systems we all have to deal with when we dial in to for example top up our mobile account, or talk to
tech support. T he letters in the acronym stand for Interactive Voice Response. An Interactive Voice
Response System is therefore a voice menu structure using dial tones to make selections.

K

Kerne l - T he Linux kernel, core of the GNU/Linux operating system. kernel.org

L

LED - Light Emitting Diode is a small indicator light.

LHS - left-hand side

Linux - A type of operating system (other common operating systems are Windows and Mac OS). Linux
has been popular as a web server for a long time and is now gaining popularity on personal laptops and
desktop computers. Linux is free software and open source.

Lo calisatio n - T he process of translating a product into different languages or adapting a language for a
specific country or region. T his is done by translators with no need for technical wizardry.

M

MAC - A unique code that is assigned to a network device.

Mo biGater - A USB GSM device that accepts a SIM card and allows Freedom Fone to communicate over
the mobile channel

MSDSIN - Mobile Number

N

Newf ies  - A dialler platform that is used to trigger outbound calls.
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NGO  - A legally constituted non-business organisation with no participation or representation from
government. In the United States, this type of organisation is more often referred to as a Non-profit.
T hey may be also called civil society organisations or not-for-profits.

NIC - Network Interface Card allows a device to be connected to a computer network.

O

Of f iceRo ute  - A SIP GSM device that accepts 4 SIM cards and allows Freedom Fone to communicate
over the mobile channel

P

PO  - Portable Object file extension

POedit  - software recommended for the translation/localisation of the Freedom Fone GUI (produces the
PO file extension)

POP3 - Post Office Protocol 3, sometimes referred to as just "POP", is a simple, standardized method of
delivering e-mail messages. A POP3 mail server receives e-mails and filters them into the appropriate user
folders. When a user connects to the mail server to retrieve his mail, the messages are downloaded from
mail server to the user's hard disk.

Pro mpt  - a prompt is short sentence you use in your voice menu "to get information on HIV/AIDS, press
1" is a prompt.

S

Screensho t  - An image of the current display on a computer screen highlighting a specific scenario.

Script  - A script is a program, usually written in an interpreted, non-compiled language such as
JavaScript, Java, or a command interpreter language such as bash. Many Web pages include scripts to
manage user interaction with a Web page, so that the server does not have to send a new page for each
change.

SIM Card - A small chip that sits inside the mobile phone that holds your mobile subscriber identity.

SIP - Session Initiation Protocol

SMS - Short text messages limited to 160 characters sent by mobile phone to mobile phone

SNMP - Simple Network Monitoring Protocol

T

To ggle  - In computing, a key or command that is operated the same way but with opposite effect on
successive occasions.
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U

Ubuntu - A variant of Linux

UI - User Interface

URL - T he URL (Uniform Resource Locator) is the address of a Web site. For example, the URL for the
World News section of the NY T imes is http://www.nytimes.com/pages/world/index.html. Many censoring
systems can block a single URL. Sometimes an easy way to bypass the block is to obscure the URL. It is
for example possible to add a dot after the site name, so the URL http://en.cship.org/wiki/URL becomes
http://en.cship.org./wiki/URL. If you are lucky with this little trick you can access blocked Web sites.

USB - universal serial bus, a standardized technology for attaching peripheral devices to a computer.

V

Vers io n - Updates to software are released periodically, and these releases are referred to as a version
of the software. T here are different types of version, for example the most recent release of a software
which has been tested and is intended for general use is referred to as the stable version, while a very
new untested version is the alpha version. 

W

Wiki - A web-based software that enables anyone to edit content via a web browser. Wikipedia is the
best known example of a wiki.
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